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Important Information

Thank you for purchasing the GCC RX II Series Cutting Plotter.

Before you use the cutting plotter, please make sure that you have read the safety

precautions and instructions below.

Caution

!
SAFETY PRECAUTIONS!

Ø For safety concern, please always hold the cutter firmly from the bottom while moving it.  Do

not move the cutter by clasping the depression area on both sides.

Ø Do not shake or drop the blade holder, a blade tip can fly out.

Ø During an operation, do not touch any of the moving parts of this machine (such as the

carriage). Also be careful to make sure that clothing and hair do not get caught.

Ø Always connect the power cable to a grounded outlet.

Ø Always use the accessory power cable which is provided. Do not wire the power cable so that

it becomes bent or caught between objects.

Ø Do not connect the power cable to branching outlet to which other machines are also

connected, or use an extension cable. There is danger of overheating and of mis-operation of

the machine.

Ø Keep the tools away from children where they can reach.

Ø Always put the pinch rollers within the white marks.

O (Correct)
Hold from the bottom

X (Incorrect)
Hold the depression area
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Warning

Never press the top release grip and pull the bottom release grip at the same time as the pictures

shown below:

O (CORRECT) ╳ (INCORRECT)

Press down

top release grip

DISABLE

ENABLE

Pull up bottom to release grip

Note:

In case the grips clipped

together due to your

wrong operation, please

use a pair of tweezers to

pull out the stop bar

when pressing down the

top release grip. Keep

the stop bar outside then

release the grips as the

right figure.
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Chapter 1 General Information

1.1 Introduction

RX II series cutting plotters have been designed to produce computer-generated images or perform
contour cutting on sheets or rolls of vinyl media.

This manual covers the following models of RX II series cutting plotters:

‧ RX II-61 for media width: 50mm (1.97”) ~ 810mm (31.88”)

‧ RX II-101S for media width: 50mm (1.97”) ~ 1326mm (52.2”)

‧ RX II-132S for media width: 50mm (1.97”) ~ 1635mm (64.37”)

‧ RX II-183S for media width: 50mm (1.97”) ~ 2145mm (84.44”)

1.2 Package Items

The package of the RX II series contents the items listed below, please check carefully.
If you find any item missing, please consult your local dealer for further assistance.

SSttaannddaarrdd IItteemm QQuuaannttiittyy

1. Cutting Plotter 1

2. Stand Set ( for RX II-101S/132S/183S only )(Optional for RX II-61)
l 2 piece of T-shape stand
l 1 piece of stand beam
l 18 pieces of M6 screws
l 1 piece of M5 L-shape hexagon screw driver
l 1 piece of Installation Guide for Stand Set

1
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3. Flexible Media Support System Package
Items 183S/132S/101S 61
1 set of Roll Media Flange (2 pieces) V V
1 set of Roll Holder (2 pieces) V V

1 set of Roll Holder Guide Bushes (4 pieces) V V

1 set of Roll Holder Support (2 pieces) V V
1 piece of M6 L-shape hexagon screw driver V V
1 piece of Installation Guide for Roll Holder V

1 piece of M5 L-shape hexagon screw driver V

1 set of Desktop Support Brackets (2 pieces) V
4 pieces of Plastic Foot V
4 pieces of M4 screws V
12 pieces of M6 screws V
1 piece of M4 L-shape hexagon screw driver V

1

4. Accessories
l 1 piece of AC power Cord
l 1 piece of data cable (USB cable: 3m)
l 1 piece of Ethernet cable
l 1 set of Blade Holder Assembly (Installed in tool carriage of the cutting plotter)
l 1 piece of Blade (Installed in Blade Holder)
l 1 piece of Safe Blade
l 1 piece of Cutting Pad for Vinyl cutting
l 1 piece of Tweezers
l 1 piece of Promise Card

1

1.3 Product Features

The following are the main features of the RX II series cutting plotters:

‧ Triple port (USB, serial and Ethernet port) connectivity
‧ Up to 600-gram cutting force
‧ Up to 1530 mm per second (60 ips) cutting speed (at 45° direction)
‧ Can work with up to 0.8mm (0.03in) thick material
‧ Guaranty 10-meter tracking
‧ User friendly and multi-language control panel
‧ Enhanced Automatic-Aligning System (AAS II) for automatic contour cutting
‧ Ingenious media basket (optional item)
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1.4 Appearance of RX II Series

1.4.1 The Front View (Figure 1-1)

Control panel – consists of 14

control keys and 1 LED and 1 LCM

showing messages and menus.

Cutting Pad – provides the

protection of blade when the blade is

cutting.

Tool Carriage – performs the

cutting with the installed blade

and pen with AAS module.

Alignment Rulers –

media can be aligned

with the clear guide line

marks.

Grid Drums – move

the media back and

forth during operation.

Slicer Groove –

slice off the extra

media easily along

this groove.

Platen – provides the

surface for holding and

supporting media while

performing cutting.

Figure 1-1
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1.4.2 The Back View (Figure 1-2)

Pinch Rollers –

hold the media during

cutting.

Lever –

raises or lowers the

pinch rollers.

Figure 1-2
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1.4.3 The Whole View of RX II Series (Figure 1-3)

Figure 1-3

Roll Holder – holds

and supplies the roll

media for cutting.

Roll Holder Guide
Bushes – serve to

keep the roll media in

place when media is

pulled from the roll.

T-Stand –supports

the cutting plotter

body.

Stand Beam –

stabilizes the body.

Roll Holder
Support – supports

roll holders.

T-Stand –supports

the cutting plotter

body.
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1.4 4 The Left-hand Side (Figure 1-4)

1.4.5 The Right-hand Side (Figure 1-5)

Fuse – 3 Amp.

AC Power Connector – used to insert the AC power cord.

Power Switch – On when switches to [I]; Off to [O]

Figure 1-4

Ethernet Connector– used to connect your
computer to a local area network.

Figure 1-5
USB Connector – used to connect the cutting
plotter to a computer through a USB cable.

Serial Interface Connector (RS232C) – used
to connect the cutting plotter to a computer
through a serial interface cable.
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1.4.6 Pinch roller (Figure 1-6)

The Multi-Pressure Pinch Rollers give users three pressure settings to better cater to the different
types of media that they are working with, for example, set light hold-down pressure of the pinch
roller in the middle when cutting thin materials such as window tinting film.

Light         Medium Heavy

Please note that the pressure of the pinch rollers on the left and right sides should always be the same
or heavier than the pinch rollers in the middle. The pressure of the pinch rollers on the left and right
sides should be set to the same pressure setting. You can use the following combinations of the pinch
rollers. (Table 1-1)

Left side Middle Right side

Heavy Medium Heavy

Medium Medium Medium

Medium Light Medium
Right side

Left side

Middle

Figure 1-6

Table 1-1
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Chapter 2 Installation

2.1 Precaution

Please read below information carefully before you start installation.

Notice 1
l Make sure the power switch is off before installing the cutting plotter.

l Carefully handle the cutter to prevent any injuries.

Notice 2 Choosing a proper place before setting up the cutting plotter
Before installing your cutting plotter, select a suitable location, which meets the following
conditions.

l The machine can be approached easily from any direction.

l Keep enough space for the machine, accessories and supplies.

l Keep the working area stable, avoiding sever vibration.

l Keep the temperature between 15 and 30℃ (60-86oF) in the workshop.

l The relative humidity of the working environment should be between 25% and 75%.

l Protecting the machine from dust and strong air current.

l Preventing the machine from direct sunlight or extremely bright lighting.

Notice 3 Connecting the Power Supply
Check the plug of the power cord to see if it matches with the wall outlet. If not, please contact
your dealer.

l Insert the plug (male) into a grounded power outlet.

l Insert the other end (female) of power cord into the AC connector of cutting plotter.

Notice 4 Tightening or Loosing Screws with Screwdriver
Whether manual or electric screwdriver, be careful not to use excess torque force when tightening
or loosing screws. When tightening or loosing iron and stainless steel screws, please refer to the
following screw torque standard table, other materials screws are not included.

Screw
diameter

Torque value (kgf-cm)
Torque standard for high hardness materials

M3 6
M4 16
M5 30
M6 50
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2.2 Stand & Flexible Media Support System (for RX II-101S/132S/183S)

Step 1
Please examine supplied items in the accessory box of stand carton:

l 2 pieces of base beams
l 2 pieces of side beams
l 1 piece of stand beam
l 20 pieces of M6 screws
l 1 piece of M5 L-shape hexagon screw driver
l 1 piece of Installation Guide for Stand Set

Step 2
l Remove the plotter body and the accessories from the shipped carton.
l Assemble the base beam to the side beam with 2 screws to form a T-shape stand. (See

Figure 2-1)

Please pay attention to the direction of the base beam (the wheel on the front end of the beam
comes with a break while the rear one is on its own).

Figure 2-3

Figure 2-1

Front Rear

Figure2- 2

Figure 2-2
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Step 3

Place the stand beam upright on the T-stand and follow numberuv to assemble (See Figure 2-4
& 2-5). There is hexagon socket head screws fasten on the T-stand on both side taken as locating
pins.

Step 4
Position the stand beam perpendicularly to partuand put the screws into the holes and tighten
them as Figure 2-5. Then the complete picture of stand will be like Figure 2-4.

Step 5
Remove the cutting plotter from the carton. Position your stand under the plotter, on the bottom
of the plotter, there is one hole on each side in the position corresponding to the locating pins, so
the locating pins can be located into the holes. Then insert the screws into the holes on the stand
to fix the plotter and tighten them up as shown in Figure 2-6.

w Stand beam

Figure 2-4

Figure 2-5

u T-Stand

v Stand beam

Screws
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Step 6
Insert the roll holder support with the screws into the holes of the stand, and then tighten them up
as shown in Figure 2-7. You could decide roll holder support’s position by inserting into different
holes.

Step 7
Place two roll holders onto the roll holder support and ensure the white protrusion is wedged in
the groove. (Figure 2-8)

Roll holder support

Roll holders

Figure 2-8

3 screws

Roll holder support

Figure 2-7
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Step 8
Turn the screw counter-clockwisely for around three times after unpacking the roll holder (Figure

2-9).

Step 9
Insert the end of the roll holder without the damper into the left roll holder support and then
insert the end of the roll holder with the damper into the right roll holder support and ensure the
white protrusion is wedged in the groove (Figure 2-10).

Figure 2-10

Figure 2-9
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Step 10
Tighten the screw on the damper until it is securely attached to the right roll holder support (Figure

2-11).

Step 11
Lastly, the complete picture will be shown like below. (Figure 2-12)

Figure 2-12

Figure 2-11
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2.2 Stand & Flexible Media Support System (for RX II-101S/132S/183S)

Step 1
Please examine supplied items in the accessory box of stand carton:

l 2 pieces of base beams
l 2 pieces of side beams
l 1 piece of stand beam
l 20 pieces of M6 screws
l 1 piece of M5 L-shape hexagon screw driver
l 1 piece of Installation Guide for Stand Set

Step 2
l Remove the plotter body and the accessories from the shipped carton.
l Assemble the base beam to the side beam with 2 screws to form a T-shape stand. (See

Figure 2-1)

Please pay attention to the direction of the base beam (the wheel on the front end of the beam
comes with a break while the rear one is on its own).

Figure 2-3

Figure 2-1

Front Rear

Figure2- 2

Figure 2-2
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Step 3

Place the stand beam upright on the T-stand and follow numberuv to assemble (See Figure 2-4
& 2-5). There is hexagon socket head screws fasten on the T-stand on both side taken as locating
pins.

Step 4
Position the stand beam perpendicularly to partuand put the screws into the holes and tighten
them as Figure 2-5. Then the complete picture of stand will be like Figure 2-4.

Step 5
Remove the cutting plotter from the carton. Position your stand under the plotter, on the bottom
of the plotter, there is one hole on each side in the position corresponding to the locating pins, so
the locating pins can be located into the holes. Then insert the screws into the holes on the stand
to fix the plotter and tighten them up as shown in Figure 2-6.

w Stand beam

Screws

Figure 2-4

Figure 2-5

u T-Stand

v Stand beam
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Step 6
Insert the roll holder support with the screws into the holes of the stand, and then tighten them up
as shown in Figure 2-7. You could decide roll holder support’s position by inserting into different
holes.

Step 7
Place two roll holders onto the roll holder support and ensure the white protrusion is wedged in
the groove. (Figure 2-8)

Roll holder support

Roll holders

Figure 2-8

3 screws

Roll holder support

Figure 2-7
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Step 8
Turn the screw counter-clockwisely for around three times after unpacking the roll holder (Figure

2-9).

Step 9
Insert the end of the roll holder without the damper into the left roll holder support and then
insert the end of the roll holder with the damper into the right roll holder support and ensure the
white protrusion is wedged in the groove (Figure 2-10).

Figure 2-10

Figure 2-9
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Step 10
Tighten the screw on the damper until it is securely attached to the right roll holder support (Figure

2-11).

Step 11
Lastly, the complete picture will be shown like below. (Figure 2-12)

Figure 2-12

Figure 2-11
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2.5 Instruction of Damper Roller

Turn the wheel as instructed below to adjust damping. The bigger the number is, the stronger the
damping. The volume symbol sticker indicates the damping level (Figure 2-18,19).

Figure 2-19

Figure 2-18
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2.6 Blade and Blade Holder Installation

2.6.1 Blade Installation
Figure 2-20 is the illustrator of the blade holder. Insert a blade into the bottom of the blade holder
and remove the blade by pushing the pin. Make sure that your fingers are away from the blade tip.

Step 1
Install blade (Figure 2-21).

Step 2
Push the blade to the bottom of the blade holder. (Figure 2-22).

Step 3
Adjust the blade tip to suitable length by screwing “Blade tip adjustment screw” clockwise or
count-clockwise. (Figure 2-23).

Figure 2-23

Figure 2-22

Tips:
“The proper length” means the blade’s length is
adjusted 0.1mm more than film’s thickness. That
is, if the thickness of film is 0.5mm, then blade’s
length is properly adjusted 0.6mm and it can
completely cut through the film layer yet avoid
penetrating the backing.

Figure 2-20

Pin

Outward ring

Adjustment depth knob

Figure 2-21
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2.6.2 Blade Holder Installation
Step 1
Insert the blade holder into tool carriage. Please note the outward ring of the holder must put into
the grooves of carriage firmly (see Figure 2-24), then fasten the case (Figure 2-25).

Figure 2-24 Figure 2-25

Step 2
Use the reversing steps to remove the blade holder.

Step 3
Eject the blade. Push “Blade eject pin” to eject blade when the blade needs to be replaced.

Caution!!
The blade will lose its sharpness after a period of usage; the cutting quality might be
affected. By increasing the cutting force, it might do the trick. However, once the
blade is worn out and no longer provides a reliable cutting, you should replace a
new one. The blade is consumable and must be replaced as often as necessary to
maintain the cutting quality. The quality of the blade deeply affects cutting quality. So
be sure to use a high quality blade to ensure good cutting results.
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2.6.3 Extension Holder Installation
Extension holder is used to move the blade holder to be positioned above the groove of the
bottom to prevent the blade from dull easily when doing die-cutting. The extension holder needs
to be installed to the carriage, then insert the blade holder into the extension holder. Plase follow
the step by step instruction below.

Step 1 Remove the case from the carriage.

Step 2 Insert the screw into the hole on the extension holder, and then fasten the case to the
carriage. Please note the flange of the holder extension must put into the grooves of carriage.

Extension holder

Screw Extension holder
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Step 3 Insert the blade holder into extension holder.

Step 4 Fasten the thumb screw to fix the tool carriage.

Step 5 The machine is ready to use.

Step 6 Use the reversing steps to remove the blade holder.
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Figure 2-26 Figure 2-27

2.7 Automatic Blade Length Detection

Figure 2.-26 is the new blade holder with a scale and the carriage with a mark. This blade holder
detects blade length automatically and shows how the knob needs to be turned on the LCM.

There are 10 units on the scale; each unit equals to 0.05 mm, allowing you to adjust the blade length for
0.00mm-5.00mm (Figure 2-27).

Follow the steps below to adjust the length of the blade:

1. Keep the blade tip within the blade holder before you start adjusting.

2. Align one of the scales on the blade holder to the mark on the carriage

3. Select “Blade Length Adjust” under “CUT TEST” on the LCM, enter the blade length wished in
“Set Length”; test the blade holder first and then test the blade length by pressing ENTER.

Note: Keep the blade holder at the same position when you perform blade holder and blade length
tests.

4. When blade holder and blade length tests are finished, the screen will show you to what
degree (the unit of the value following “CW” or “CCW” is “circle”) and in which direction [CW
(clockwise) or CCW (counterclockwise)] you should turn the adjustment knob.
EG, Turn CW 5 is telling you that you should turn the knob for 5 units clock-wisely (Figure 2-28,
Figure 2-29).

Mark

Scale

1 unit
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Figure 2-29Figure 2-28

5. The screen will show "Adjustment completes" when the value on the screen is 0, the blade
length is perfect and no more adjustment needs to be made. Press "Enter" now to complete
the process and you may start cutting at this point.
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2.8 Creasing Tool Installation

Step 1 Remove the Creasing tool and holder from the carriage.

Step 2 Make sure the cylinder is at “UP” position
Press the cylinder by hand and hold the bottom to ensure the VCM to be hold while pressing as
shown on below pictures.

Step 3 Insert the creasing tool into the holder tube

Up Down
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Step 4 Make sure the tool is insert to the bottom of the holder tube and turn the hand screw to lock its
position

Step 5 Place the high adjustment jig under the creasing tool position and insert the creasing tool holder.
(Make sure the cylinder is in “DOWN” position)

Press down the tool tip
to ensure the toll is set at
the bottom of the holder
tube

Turn the hand screw to
lock the position



RX II Series User Manual

Installation 2-21

Step 6 Press the top of the creasing tool and hold at bottom of the cylinder to ensure the holder is set
at the proper high.
Note: Lower finger have to hold the system up.

Step 7 Turn the lower hand screw to lock the position of creasing toll and holder
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2.9 Cable Connection

The cutting plotter communicates with a computer through a USB (Universal Serial Bus), Serial port

(RS-232C) or an Ethernet port. This chapter shows you how to connect the cutting plotter to a host

computer and how to set up the computer/cutting plotter interconnection.

!! Notice: When USB connection is enabled, the serial port will be disabled automatically.

2.9.1 USB Interface
RX II series build-in USB interface are based on the Universal Serial Bus Specifications Revision 2.0
(Full Speed).

2.9.1.1 Connecting your GCC cutter
1. Turn on the machine.
2. Connect the USB connector to the machine and then USB driver will installed automatically. It

will take a few minutes to find the device. Please DO NOT disconnect the USB cable until the
installation has completed.

3. You can double click the USB icon on the taskbar to make sure the USB device is detected.

2.9.1.2 Installing the driver
Use the USB One-click Installation for quick driver installation. Follow the simple steps below for
driver setup.

Figure 2-30

Serial portUSB port

Ethernet port
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Step 1 Visit GCC website and go to “SUPPORT” page to download the user manual, driver and
software (https://www.gccworldnew.com/download.php). Please make sure that the USB device
is connected before you start the driver installation.

Step 2 You may use search function or directly click the product category to choose the model you
want.

Caution!!
ü If you are using Windows 7 and above as your operating system, make

sure you log in using the “Administrator” account.

https://www.gccworldnew.com/download.php
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Download the driver according to the type of connection.
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Step 3 Unzip the file and double clip the driver.exe to start installing the Driver and AAS plug-in.

Step 4 If you were Windows 7 and above users, please click on the red words to instruct you how
to disable Windows Update to allow success driver installation. And then click OK to next step.

Step 5 Please make sure the cutting plotter is powered on and connected to the USB device, and
then click OK to next step.

Step 6 Confirm to close all running application programs before you start installing the driver, and
then click OK.

Step 7 The installation will take a few minutes to complete and you will see a message below and
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click on “OK” upon completion. Enjoy your GCC cutter!

Step 8 If you want to install AASII VBA on CorelDRAW and Adobe Illusatrator, exit CorelDRAW and
Adobe Illusatrator program, and then click on“Install.”

Step 9 Check Install Message to confirm CorelDRAW and AI version and then click OK.

Note:
(1) If the driver is being installed for a second time, the user will be prompted as to whether a

second copy of the driver installation is required.

(2) If the user selects yes, a second copy of the driver will be installed.
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(3) For users who have upgraded Adobe Illustrator or CorelDRAW, please go to the AAS Installer

page in the Printer Properties window and click “Install” to access the latest version of GCC AAS

Plug-in.

2.9.1.3 Driver Un-installation

You have to remove previous version driver installed on your PC system completely before you can
install the latest version successfully. Please refer to below steps.

Step 1 Go to Control Panel\Hardware and Sound\Devices and Printers window. Right click the
printer and select “Remove device.”
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Step 2 After removing the unit, click on any printer on the page and select “Print server
properties.” (For Win 7 and above)
Or right click on blank space and then select “Print server properties.” (For Windows XP)
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Step 3 Select “Driver” page

Step 4 Select the model and click on “Remove”.
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Step 5 Select “Remove driver and driver package” and click OK.

Step 6 Click Yes and then click “Delete” and “OK,” and the driver installed on PC is completely
removed.
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2.9.2 RS-232 Interface
n Connecting to the RS-232 (Serial) Port

1. For IBM PC, PS/2 users or compatibles, connect the RS-232C cable to the serial connector
of the assigned serial port (COM1 or COM2) of your host computer.

2. Set up the communication parameters (Baud Rate and Data Bits/Parity) to match the
setting of software package, refer to chapter 3 – “MISC” key description.

2.9.3 Ethernet Connection

I. Networking Connectivity Setup

Step 1 Connect the LAN port and Ethernet port on GCC cutting plotter with RJ45 Ethernet cable,
and turn on the machine.

Step 2 Press On/Off line and then MISC button on your control panel.

Caution!! Please turn off the plotter before plugging the RS-232C cable.

1

2
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Step 3 Go to the DHCP page and select Enable through the up and down arrow keys, then press
Enter.

Step 4 The IP Address will be shown on the screen automatically. Please make notes of it.

II. Ethernet Connectivity Setup

There are two ways to output your plot through Ethernet. If you output your plot through GreatCut,
please follow the instruction I. Output through GreatCut; if you output your plot through Adobe
Illustrator or CorelDRAW, please follow the instruction II. Output through the Ethernet Driver.

I. Output through GreatCut

GreatCut is a plug-in for CorelDRAW and Illustrator. (GreatCut installation please refer to chapter
2.9.1)

Instruction of Ethernet settings for GreatCut

Step 1 Open GreatCut and create a new file and cutting line.

Step 2 Go to Output Devices under Settings.
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Step 3 Select a model at Driver in Setup Device window

Step 4 Input the IP address you had acquired from the control panel to the TCP/IP. Click OK to
complete settings.

Step 5 Go to Output under File to check the settings.
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Complete the driver installation process and your GCC Cutting Plotter is now allowed to network.

Note: If you want to add new local device, please go to Output Devices under Settings, and press
the button on the right of Current Output Device and select Add local device (if the device has
been installed but you wanted to output through another device, please select Change to set the
IP address of another device).

II. Output through Ethernet Driver
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Step 1 Connect Ethernet cable to PC and install Cutter Ethernet driver. Then click OK to continue.

Step 2 Enter the IP Address shown on the control panel and select the model. (Please refer part 1
instruction.)

Step 3 The driver is installed. You can output from AI or CorelDRAW directly now.

2.9.4 Data Transmitting

There are two options to transmit the data from the computer to the cutting plotter:

Option 1: With proper interface settings, the data can be transmitted from your application
software package to the cutting plotters directly.

Option 2: Most cutting software packages are able to emulate HP-GL or HP-GL/2 commands. As
long as the file is HP-GL or HP-GL/2 format, the cutting plotter can output the data precisely.
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2.9.5 Printer Sever Shared Setting

In “A-PC”, set the printer driver as a shared printer, then use B-PC to connect A-PC’s printer driver
via internet.

A-PC B-PC

Step 1
Please set A-PC’s printer driver to shared printer. (Right-click on printer icon, choose “Printer
properties”. Click “Sharing” tab then check “Share this printer”)

Internet

USB COM Port
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Step 2
Click “Advanced” tab, then choose “Print directly to the printer” option.

Step 3
Send a job to the machine to check if A-PC is connected to the machine.

Try to send a job
to check if the port
is working.
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Step 4
Activate A-PC’s Printer Driver from B-PC’s Network.

Step 5
Right-click on the printer icon, and select “Connect” to connect A-PC’s printer.
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2.10 Software Installation

2.10.1 GreatCut-S Installation

2.10.1.1 Auto Installation
1. Visit http://gccf.gcc.com.tw/gccclub/login.aspx and log in your GCC Club account.

or create a new GCC club account if you do not have one. Click “I Agree”, fill in the required
information and click “Submit” to sign up.

http://gccf.gcc.com.tw/gccclub/login.aspx
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You should receive an eMails with activation link and click the link to activate your account.

2. Go to GCC Club, click “GreatCut-S voucher code” on the left side.

3. Enter your voucher code and click “submit”.
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4. You will get your GreatCut-S serial number.

5. Visit https://www.gccworld.com/download.php click the product category and choose
aproper model.

https://www.gccworld.com/download.php
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6. Download GreatCut-S to start the installation.

7. Press Next to continue, tick “Launch GreatCut-S” and then press “Finish” to compete the
installation.

8. Run GreatCut-S and press “Activate…”to activate GreatCut-S. Please make sure it is connected
to the internet.
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9. Enter your name in the Name column and GreatCut-S serial number to the Serial column and
press “OK” to complete the activation.

10. GreatCut-S is ready to use.

2.10.1.2 Manual Activation
If the computer connected to the cutter doesn't have an internet connection to complete the
software activation process, you can alternatively use the "Activate manually" function to enter the
"Activation Code" and begin using GreatCut-S. However, you will need to find another computer
with internet access in advance to obtain the "Activation Code" by following the instructions
below.

1. Check the "Activate manually" checkbox and you should see the Site Code and Activation
Code fields appear. The Site Code field will be pre-filled in and cannot be changed.

Note
ü If you use a trial version to output graphics,

meaning you do not enter the software key to
activate the Sure Cuts A Lot mentioned above,
there will be two extra lines cut through the
design, therefore, make sure the Sure Cuts A Lot
software is activated before implementing cutting
jobs.
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2. Visit https://craftedge.com/activation/greatcut/ via an internet connected computer. Enter
your name, serial and site code.

3. Click on the "Generate Activation Code" button, and your activation code will be shown in the
Activation Code field.

4. Copy and paste the activation code back into the activation dialog box of Sure Cuts A Lot
program and hit ok.

https://craftedge.com/activation/greatcut/
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5. Click OK and GreatCut-S is ready to use.

2.10.1.3 Re-install GreatCut-S Software
If you change a new computer, you may need to deactivate your GreatCut-S software and re-install
it on your new device.

Go to “Deactivate…” under Help and press Yes to confirm, then follow the installation procedure
and use the same code to activate it on another computer.
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2.10.1.4 Reset GreatCut-S Serial Code
If you need to re-install the software again due to problems such as a computer crash/reformat
where you were not able to de-activate your copy off the computer first, you may visit
https://craftedge.com/activation/deactivateGC.php to reset your serial number

https://craftedge.com/activation/deactivateGC.php
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2.10.2 SmartCUT Installation

SmartCUT is a software used for barcode cutting functionality, available for download on the GCC
website’s dowolaod area.

1. Download SmartCUT to start the installation.
2. Press Next to continue, and then press “Finish” to compete the 

installation.

3. Run SmartCUT and it is ready to use.
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2.11 Auto Cut-off system Installation

Step 1 Unscrew the Cover from the Tool Carriage using a screw driver.

Step 2 Manually disassemble the Cover, which will still be connected to the Tool Carriage through
wires.
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Step 3 Disconnect the black and red wires between the Cover and the Tool Carriage from the white
Wire Joint and the Cover will be removed completely.
Note: Please disconnect the wires at the white Wire Joint with care as the fans will not be
working if these wires are split elsewhere.

Step 4 Remove the screw on the left of the Cut-off Unit manually (Figure 2-37 and 2-38).

Wire
Joint

Cut-off Blade Fixer

Screw
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Step 5 Remove the entire Cut-off Unit by holding it while pushing the tiny metal board on the right
to the left.

The Cut-off Unit will drop automatically once the board is pushed to the left (above picture).

Push to the left

Metal board

Figure 2-39

Push to the left

Metal board
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Step 6 Remove the screw from the Cut-off Unit.

Disassemble the Cut-off Blade Fixer by pulling it up vertically

Screw
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Step 7 Unscrew the Cut-off Blade from the Cut-off Blade Fixer, which will be attracted by the
magnet on it, and replace it with a new Cut-off Blade along the track highlighted in red using
tweezers.

Note: The Cut-off Blade is sharp so please handle with care.

Old Cut-off Blade

New Cut-off Blade

Magnet
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Step 8 Assemble the Cut-off Blade Fixer back to the Cut-off Unit by pushing the Holder downwards.

Then attach the screw

Step 9 Assemble the Cut-off Unit back
to the Tool Carriage by pushing the metal board on the right while pushing the Cut-off Unit
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upwards.

Then attach the screw

Step 10 Reconnect the wires at the white Wire Joint.

Push to the left
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Step 11 Assemble the Tool Carriage Cover back to the Tool Carriage; please locate the end of the
screw to the hole on the carriage before tightening the screw.

End of Screw
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Chapter 3 The Control Panel

This chapter describes the button operations with the LCM menu flowcharts of RX II series.
When the cutting plotter is ready for use as described in Chapter 1 & 2, all functions are under
default parameters.

3.1 The Touch Key Panel

< Touch Key Panel on RX II series >

Key Function

LCD Screen To display functions and error messages.

Power LED To indicate the power status ( light up: power on; light off: power off )

4 Arrow Keys To move position, select function, or change setting.

ENTER To set item or register the immediately preceding input value.

PAUSE/RESUME To temporarily halt cutting process or to continue

ON/OFF LINE To switch modes, stop cutting job, or abort changes of settings.

OFFSET To adjust the value of blade’s offset.

FORCE To adjust the value of cutting force.

SPEED To adjust the value of cutting speed and quality.



RX II Series User Manual

The Control Panel 3-2

CUT TEST To perform cutting test on different media.

CUT OFF To cut off the material when the job is completed.

MISC To set up functions.

TOOL SELECT To select tools.

DATA CLEAR To clear up internal memory.
Please see details in “3.4 Menu Items”
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3.2 Menu in On-line Mode
Power on When Setting Paper

When Media Is Detected

Main Menu

3.3

Set Tangential Mode
Select: OK:ENTER

Pouncing: 0 mm
Select: OK:ENTER

OverCut: 0.00mm
Select: OK:ENTER

Set Smoothing Cut
Select: OK:ENTER

1S:72 F:80 O:0.275 M
Select: OK:ENTER

Clear Data Memory
N:ONLINE OK:ENTER

Offset: 0.275 mm
OK:ENTER

C Force: 80 gf
OK:ENTER

P Force: 80 gf
OK:ENTER

C Speed: 72 cm/s
Select: OK:ENTER

P Speed: 72 cm/s
Select: OK:ENTER

C Quality: 72 cm/s
Select: OK:ENTER

P Quality: Normal
Select: OK:ENTER

Up Speed: 72 cm/s
Select: OK:ENTER

Firmware: X.X Copyright: GCC

Place Media And Then
Lower Down The Lever

Roll Edge Single

Key Key Key

Load: Pull Lever Up
To Setup: Valid Keys

To Load: Place Media
To Setup: Valid Keys

use to select

Initializing RX
Please Wait…

Press Function Key
IF NEEDED

** Please Don’t **
*** TOUCH ANY KEY ***

Now Sizing Media

Sizing Media Length
Lever Up to Abort

Sizing Media Width
Lever Up to Abort

Pause Setup Resume

Sending data [PAUSE ]

[ FORCE]
use to select; [ENTER] to enable the setting

，按[ 确认 ]保存

[ SPEED ]

key ]

[ OFFSET ]

[ DATA CLEAR ]

[TOOL SELECT ]

S 72 F 80 O 0.275
L:150000 W:327 T1M

AAS Speed: Medium
Select: OK: ENTER
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Blade Length Adjust
Select: OK:ENTER

Set Length    0.00mm
Change: OK: ENTER

Test Blade Holder
OK: ENTER

Test Blade Length
OK: ENTER

Turn CW           O Turn
N:ONLINE     OK: ENTER

Adjustment completes
OK: ENTER

Ratio: 100%, 200%, 300%, 400%

Ratio Setting
Select: OK:ENTER

Pattern: Cross, ArrowPattern Setting
Select: OK:ENTER

Ratio: 100%
Change: OK: ENTER

Pattern: Arrow
Change: OK: ENTER

Menu in Off-line Mode
Offline For System Setup

Square Cut
Select: OK:ENTER

[CUT TEST ]

Repeat AAS Job
Select: OK:ENTER

Redo Jobs in Memory
Select: OK:ENTER

Recut #1
Select: OK:ENTER

Copy           #1
Select: OK:ENTER

Recut number: 0-99

Copy number: 1-999

After sending AAS job

move origin M
X: Y:

[ ]

Draft, Fair, Normal, Fine, Small Letter

C Speed: 3~153 with an increment of 3 (cm/s)

[ SPEED ]

Draft, Fair, Normal, Fine, Small Letter

C Speed: 72 cm/s
Select: OK:ENTER

UP Speed: 3~153 with an increment of 3 (cm/s)

P Speed: 72 cm/s
Select: OK:ENTER P Speed: 3~153 with an increment of 3 (cm/s)

UP Speed: 72 cm/s
Select: OK:ENTER

C Quality: Normal
Select: OK:ENTER

P Quality: Medium
Select: OK:ENTER

[ FORCE] 5~600 with an increment of 5 (gram force)C Force:80 gf
OK:ENTER

P Force:80 gf
OK:ENTER 5~600 with an increment of 5 (gram force)

[ DATA CLEAR ]

CLEAR ]
Clear Data Memory
N:ONLINE OK:ENTER

[ OFFSET ] Offset: 0.275 mm
OK:ENTER 0.000~1.000 with an increment of 0.025 (mm)

Cutting off Paper
N:ONLINE OK:ENTER

AAS Speed: Medium
Select: OK: ENTER High, Medium, Low

[CUT OFF]
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Cancel Restore
Change: OK: ENTER

Sure to Restore
Change: OK: ENTER

OverCut: 0.00mm
Select: OK:ENTER

Pouncing 0 mm
Select: OK:ENTER

Offline For System Setup

OverCut: 0.00~1.00mm with an
increment of 0.05mm

[ TOOL SELECT]

1S:72  F:80   O:0.275 M
Select: OK:ENTER

Set Smoothing Cut
Select: OK:ENTER

Set Tangential Mode
Select: OK:ENTER

Panel Setup
Select: OK:ENTER

Pouncing: 0~200mm with an
increment of 1mm

Factory Default ?
Select: OK:ENTER

[ MISC]

Enabled, Disabled
Auto Unrolled Media
Select: OK:ENTER

Rear Paper Sensor
Select: OK:ENTER Enabled, Disabled

Vacuum
Select: OK:ENTER Enabled, Disabled

First Back To Origin
Select: OK:ENTER

AAS Copy
Select: OK:ENTER

Paper Saving Mode
Select: OK:ENTER

Scale Length
Select: OK:ENTER

Scale Width
Select: OK:ENTER

Select from 1S to 4S

Auto Unrolled Length
Select: OK:ENTER

Auto Unrolled Speed
Select: OK:ENTER

Unrolled 500~3000mm

Slow, Normal, Fast

Sizing Setting
Select: OK:ENTER

Enabled, Disabled

Pen_Blade Offset
Select: OK:ENTER

AAS Offset
Select: OK:ENTER

AAS Detect Mode
Select: OK:ENTER

Forward Direction, Auto
Direction, Reverse Direction

Adjust Paper
Select: OK:ENTER ±40mm with an increment of 0.5mm

Graph Start atM
X:          Y:

Switch of Pen
Please Wait……

Switch of Cutter
Please Wait……

Pen overlap Cut
X:          Y:

Redo P-B Offset Test
N: ONLINE     OK:ENTER

AAS Ext. Offset
Select: OK:ENTER

X, Y:
-10.000~10.0
00

USER Defined, Default
EDGE, Default ROLL
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Pen Height Detect
Change: OK: ENTER

3.4 Menu Items
Below describes the functions of menu items
Menu or Key Function Setting Default

--- Media sizing ---
Roll To measure media width. Maximum Media

Length 150M

Edge To measure media width and pull the media back till the front
paper sensor open.

Maximum Media
Length 150M

Single To measure media width and length. Maximum Media
Length 10M

--- POWER ---
To indicate the power status.

[ Arrow Keys ]
1. To move the tool carriage position on X or Y axis.
2. To select functions or change values of settings.

[ ENTER ]

DHCP
Select: OK:ENTER Enabled, Disabled

IP Address
Select: OK:ENTER

IP Address set, Submask set,
Gateway set

MAC Address
00:CF:52:72:03:01

Select Language
Select: OK:ENTER

Select Unit
Select: OK:ENTER

Firmware    x.x.xx
FPGA: xx.xx

English, Francais, Türkce, Polski, Ingles, Japanese,
Deutsch, Italian, Espanol

Metric (cm/g), Unit (inch/ g),
Unit (cm/ oz), English (inch/ oz)

[ MISC]
Set communication
Select: OK:ENTER

Image Scale Length
Select: OK:ENTER

Image Scale Width
Select: OK:ENTER

Section Cut
Select: OK:ENTER

OFF
Change: OK: ENTER

ON
Change: OK: ENTER

Enabled, Disabled
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1. The displayed parameters will be saved automatically.
2. To set a new origin at the present tool carriage position.

In “offline” mode, moving the tool carriage to desired
position by [Arrow Keys], then press [ENTER] key to set a
new origin. While moving with the parameters of XY-axes
displayed, press [MISC] key will enable fine-tune
movement; press [MISC] key again to disable the function.

[ PAUSE/RESUME ]
To temporarily halt the cutting process.
To resume the process by press [Pause/Resume] key again.

[ ONLINE/OFFLINE ]
1. To switch between online mode and offline mode.
2. To stop the cutting job or abort the change of setting.

Once press this key, the cutting job will be terminated
immediately and cannot be resumed.

[ OFFSET ]
To set or modify the distance between the blade tip and the
center axis. Through left or right arrow keys, users can select
the blade used (Red, Green, Yellow, Blue, Black capped
blade or Pen) then adjust the offset values after pressing
Enter if necessary

0.000~1.000mm 0.275mm

[ FORCE ]
C Force To set or modify the value of cutting blade force.

When the cutting force exceeds 450g, the maximum cutting
speed would be 15 cm/sec and the cutting quality would be
Small Letter Mode and while the cutting force is 300g-449g,
the maximum cutting speed would be 30 cm/sec and the
cutting quality would be Fine Mode.

5~600gram;
5 gram/per step

80 gram

P Force To set or modify the value of pen force.
When the pen force exceeds 450g, the maximum pen speed
would be 15 cm/sec and the pen quality would be Small
Letter Mode and while the cutting force is 300g-449g, the
maximum pen speed would be 30 cm/sec and the cutting
quality would be Fine Mode.

5~600gram;
5 gram/per step

80 gram

[ SPEED ]
C Speed To set or modify cutting blade speed at horizontal moving.

When the cutting speed exceeds 72 cm/sec, the cutting
quality would be Normal Mode.

3~153cm/sec;
3cm/sec per step

72cm/sec

P Speed To set or modify pen speed at horizontal moving. 3~153cm/sec;
3cm/sec per step

72cm/sec

Up Speed To set or modify both cutting blade and pen speed at vertical
moving.

3~153cm/sec;
3cm/sec per step

72cm/sec

AAS Speed To set or modify AAS detecting speed. High, Medium,
Low

Medium

C Quality To set or modify cutting quality (acceleration).
Draft (4.2G), Fair (2.8G), Normal (1.4G), Fine (0.7G),
Small Letter (0.2G).
While cutting small letter, set as “Small letter”.
While cutting in high speed, set as “Draft”.
For normal operation, set as “Normal”.

Draft, Fair,
Normal, Fine,
Small Letter

Normal

P Quality To set or modify plotting quality (acceleration).
Draft (4.2G), Fair (2.8G), Normal (1.4G), Fine (0.7G),
Small Letter (0.2G).
While cutting small letter, set as “Small letter”.
While cutting in high speed, set as “Draft”.
For normal operation, set as “Normal”.

Draft, Fair,
Normal, Fine,
Small Letter

Normal
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[ CUT TEST ]
Square Cut To perform a cutting test at present blade position.

For more information, please refer to “4.3 Adjusting the
Cutting Force and Offset” to adjust blade force and cutting
speed.

Redo Jobs in
Memory

To redo the cut test jobs saved in memory by recutting or
producing cut test copies

Recut (number of
jobs: 1-99)

Copy (number of
jobs: 1-999)

Recut

Repeat AAS

Job

To repeat AAS jobs automatically without having to operate
on the computer side.
Please be noted that this feature is mainly applied to the
Single paper mode; please ensure a new piece of material
you wish to apply this feature on is loaded and the origin
repositioned to the first registration mark before starting.
When the first AAS job repeat completes, the user will be
offered the choice of “Repeat AAS Job Again”, please
press ”Online/Offline” to return to the main menu.

Blade Length
Adjust

To adjust the length of the blade
Note:
1. Keep your blade length as 0 before you start adjusting.
2. Test the blade holder first and then test the blade length by

pressing ENTER.
3. Keep the blade holder at the same position when you

perform blade holder and blade length tests.
4. When blade holder and blade length tests are finished, the

screen will show you to what degree (the unit of the value
following “CW” or “CCW” is “circle”) and in which direction
[CW (clockwise) or CCW (counterclockwise)] you should
turn the adjustment knob.
EG, Turn CW 0.5 is telling you that you should turn the
knob for half a circle clockwisely.

5. The value on the screen will be 0.0 when the blade length
is perfect and no more adjustment needs to be made. You
will be prompted with the message below: Adjustment
completes and you may start cutting at this point.

0.00mm-5.00mm 0.00mm

Ratio Setting To adjust the size of the pattern. 100%, 200%,
300%, 400%

100%

Pattern Setting To provide two patterns for cut test
Note: It is recommended to select “Cross” if you are working
on thick pieces of materials.

“Arrow” and
“Cross” patterns

“Arrow”

[ DATA CLEAR ]
To clear up buffer memory.

[ TOOL SELECT ]
Save Parameter To save pattern(s) of cutting parameters for later use.

There are 4 sets of parameters saved in the panel. Use
Page Up and Page Down keys to select the set of parameters
you wish to adjust, press “Enter” to confirm (the number
shown on the upper left corner will change accordingly). Each
set of parameters includes Speed, Force, Offset, Up Speed,
Quality and Scaling though the latter three will not be
displayed in this section. To adjust or check individual
parameters, go back to the responding keys on the panel and
press “Enter” to confirm.

Pattern 1:
vinyl

Pattern 2:
window tint

Patterns 3 & 4:
default value
which could be
adjusted if
needed

Patterns 3
& 4
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Set Smoothing
Cut

To enable smooth-cutting function. Enable

Over Cut To generate an overcut to facilitate weeding. 0.00mm-1.00mm
0.05mm/per step

0.00mm

Set Tangential
Mode

To enable the tangential-cutting mode for thicker media
types and small letter cuts.
Note: while the Offset value setting at 0.000 mm, “Set
Tangential Mode” will automatically be disabled.

Enable

Pouncing To make perforated patterns.
* In order to use this function, Pouncing tool must be

installed.
* Before start pouncing, place pouncing strip on top of the

cutting pad to protect the cutting pad.
* Set the value as 0 mm to disable the pouncing mode.
* Pouncing tool is an optional item.

0~200mm 0mm

Panel Setup Accept setup command:
To accept commands of the Force, Speed, Cutting Quality,
and Offset only via software.

Accept
setup
command

Control panel only:
To accept commands of the Force, Speed, Cutting Quality,
and Offset only via control panel of the cutter.

Factory Default? To turn all parameters of the menu items to factory-default
settings.

[ MISC ]
Auto Unrolled
Media

To avoid paper jam and motor crash by automatically unroll
media (50cm and up) before cutting while enabled.  .
* Auto-unroll only effects on roll/edge media.
* Using Single mode to size media will disable this function
automatically.

* If the length of the rolled media is less than 2 meters or the
weight is light, it is recommended to set this mode disabled.

Enabled

Auto Unrolled
Length

When “auto unrolled media” is enabled, user can adjust the
unrolled media length.

500~3000mm 3000mm

Auto Unrolled
Speed

To adjust the unrolled media speed. Slow, Normal,
Fast

Normal

Adjust Paper To calibrate position of media front edge after sizing.
If the value of Adjust paper is bigger, the distance of the
media front edge will be closer to cutting blade. This setting
only works when using cutter with auto feeder, or under
single mode when using cutter alone.
(*auto feeder is an optional item for Jaguar-61 and
RXII-61-Creasing)

-40 ~ 40mm

Rear Paper
Sensor

To detect if the rear paper sensor is covered to determine the
following process; when it is enabled, the cutter will detect if
the material has covered the rear paper sensor under the Roll
and Edge mode; when disabled, the rear paper sensor will
not be functioning.
Note: Rear paper sensor only functions under “Roll” and
“Edge” mode.

Enable
Disable

Enable
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AAS Detect
Mode

To recognize the printed sheet media is fed in forward
direction or reversed direction by detecting the registration
marks.
1. Forward direction: to detect the registration marks in

forward media feeding direction
2. Auto detection: to distinguish the media feeding direction

automatically by by detecting the registration marks.
Reverse direction: to detect the registration marks in reversed
media feeding direction

Sizing Setting Allows user to set the sizing settings.
If set to user defined mode, the user will be asked to select the
size setting every time the machine is turned on.
If set to Default Edge or Roll, Edge or Roll type sizing will be
performed whenever the machine is turned on.

User Defined,
Default EDGE,
Default ROLL

User
Defined

Vacuum To help improve tracking and cutting accuracy by turning on
the fans. If you turn off the vacuum system, the fans
will remain inactive during cutting or plotting.

Enable, Disable Enable

First Back to
Origin

To enable the carriage back to the previous origin; when
“Enable” is selected, the carriage will not go back to the
previous origin while the selection of “Disable” allows the
carriage to do so.

Enable
Disable

Enable

AAS Copy To enable the AAS copy. When “Enable” is selected, the AAS
module will continue to read the registration mark to contour
cut. Users can set distance between images and AAS copy
times in this function. The range of distance is 0-500mm, and
the range of times is 0-1000.

Enable
Disable

Enable

AAS Offset/
AAS Ext. Offset

To set or modify AAS offset value.
You can refer to “5.3 Printer Test” for more details.

Adjust the offset value under AAS Offset menu when a
regular blade holder is installed; adjust the offset value under
AAS Ext. Offset menu when an extension holder is installed.

AAS Offset:
X:0, Y:0
AAS Ext.
Offset:
X:8.5, Y:3

Paper Saving
Mode

To save media by four different modes:
1. Length expanded mode   2. Width expanded mode
3. Both expanded mode     4. Both unexpanded mode

Length
expanded
mode

Pen_Blade
Offset

Correct the gap between the pen and cutter mounted on the
carriage.
1. Press the arrow keys to move the cursor to the position you
want to plot, finishing settings press “Enter” key to next step.
2. If the pen and cutter lines are not matched, please refer to
the table below for adjust X and Y values in “Pen overlap Cut”
option.
Press ← and → key switch X and Y direction.

Directions Status Key

X
↑

↓

Y

↑

↓

Black line: pen line, Red line: cut line
Scale Width Fixed scaling, for maintenance only.
Scale Length
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Image Scaling
Width

To adjust the image scale of media length and width that may
cause by the thickness of the media.

The Numerator is the ideal length, and the Denominator is
the actual length measured from the resultant.

For example, cutting a line with 500.0 mm length. The
procedure as follows:
1. Press the [LEFT ARROW] to choose the Numerator and

select 500.0 mm,
2. Cut the length by sending a graph file,
3. Measure the length then use the [RIGHT ARROW] key to

choose the Denominator, then
4. Press [UP ARROW /DOWN ARROW] to change the

values of the actual length.

Image Scaling
Length

Set
Communication

To build up the communication between host computer and
cutter.
Baud Rate is to determine the speed of data transmission.
Data Bits refers to the size of one block of data.
Parity is used to check if data was revived correctly or not.
9600, n, 7, 1, p 9600pbs, 7 Bits with NO Parity
9600, o, 7, 1, p 9600pbs, 7 Bits with ODD Parity
9600, e, 7, 1, p 9600pbs, 7 Bits with EVEN Parity
9600, n, 8, 1, p 9600pbs, 8 Bits with NO Parity
9600, o, 8, 1, p 9600pbs, 8 Bits with ODD Parity
9600, e, 8, 1, p 9600pbs, 8 Bits with EVEN Parity
19200, n, 7, 1, p 19200pbs, 7 Bits with NO Parity
19200, o, 7, 1, p 19200pbs, 7 Bits with ODD Parity
19200, e, 7, 1, p 19200pbs, 7 Bits with EVEN Parity
19200, n, 8, 1, p 19200pbs, 8 Bits with NO Parity
19200, o, 8, 1, p 19200pbs, 8 Bits with ODD Parity
19200, e, 8, 1, p 19200pbs, 8 Bits with EVEN Parity

DHCP Shows your IP address for TCP/IP Configuration Disable

IP Address Shows the IP Address of your cutting plotter.

MAC Address Shows the MAC Address of your cutting plotter.

Select
Language

To select displayed languages on LCM panel in English,
Spanish, Italian, Deutsch, Japanese, Portuguese, Polish,
Turkish or French.

English

Select Units Provide four-unit systems for users convenient. cm/s; inch/oz;
cm/oz; inch/gram

Metric

Firmware
Version

To display the version number of Firmware and FPGA code,
varying from model to model

Section Cut To divides the long plot data into sectional output jobs to gain
higher cutting quality and increase precision.

Users can set the section by registration marks or input the
value manually.

200mm
intervals

Pen Height
Detect

To detect the height of pen automatically

[ CUT OFF ]
Cut off Paper To cut off the material automatically when the job is completed,

you need to use the arrow keys to move the carriage to the
position you want to cut off the material manually and then
press the “cut off” button.
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Chapter 4 Operation
4.1 Media Loading

4.1.1 Loading the Sheet Media
To load the media properly, please follow the procedures listed below:

Step 1
Use the lever on the upper right side of the cutting plotter to raise or lower down pinch rollers.
Pull the lever forward until it makes a clicking sound then the pinch rollers are raised (Figure
4-1).

Step 2
Load your media on the platen and slide it under the pinch rollers from either the front side or the
backside. The alignment rulers on the platen extension will help you to adjust the media
precisely.

Note:
Be sure that the media must
cover the paper sensors on the
platen when loading the media.
At least one of the two paper
sensors (Figure 4-2) should be
covered. Once the media covers
the sensor, the cutting plotter will
size the media width and length
automatically.

Paper sensors

Figure 4-2

Lever

Figure 4-1
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Step 3
Then move the pinch rollers manually to the proper position. Be sure the pinch rollers must be
positioned above the grid drum. The white marks on the top trail will remind you where the grid
drums are (Figure 4-3).

Step 4
Place the media between the cutoff range.

Step 5
Push the lever backward to lower down the pinch rollers.

Step 6
Turn on the power, the tool carriage will measure the size of the media automatically.  And the
plotting cutter begins to work.

Note:
1. Always adjust the position with the pinch roller raised.
2. Move the pinch roller by applying force at the rear portion of the pinch roller support.
3. Do not move it by holding its front rubber roller (Figure 4-4).

White marks

Figure 4-3
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Note:
Please pull up the bottom of all pinch rollers (Figure 4-5) before the lever is pushed backwards
to ensure accurate media width detection.

Figure 4-4

(X)

Incorrect

ENABLE

Pull up bottom to release grip

Figure 4-5
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4.1.2 Loading the Roll Media

Step 1
Put the roll media guide bushes on two roll holders (Figure 4-6).

Step 2
-- Option A (Use the media flanges) (Recommended)

Insert a roll media flange at the end of each roll media and tighten the thumbscrew until the roll
media is firmly gripped (see Figure 4-7).

Then put the roll media on the roll holders. Adjust the position of the roll media ensure that
media flanges are able to run in the grooves of roll holder guide bushes (Figure 4-8)

Figure 4-6

Figure 4-7
Figure 4-8
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-- Option B
Insert the two roll holders into the roll media support set then place the roll media
directly between the two roll holders (Figure 4-9).

Step 3
Load the media on the platen. Please refer to “4.1.1 Loading the sheet media”. After loading
the roll media, flatten the media on the platen and hold the front edge of the roll media firmly
(Figure 4-10).

Step 4
Turn the roll downward to make an equal tension across the
media (Figure 4-11)

Step 5
Move the pinch rollers to the appraise location and note that
the pinch rollers must be positioned above the grid drums.

Note:
Make sure that the media
tension is equally distributed
from left to right. If the media
were not tightened enough
against the platen, it would
cause tracking problems!

Figure 4-11

Figure 4-9

Figure 4-10
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Step 6
Push the lever backward to lower down the pinch rollers.

Step 7
Fix roll holder guide bushes on the roll holder to secure the roll media.

Step 8
Turn on the power switch and select Roll, Edge or Single mode appropriate for one time setup,
or set to Default Roll in Sizing Setting and Roll type sizing will be performed when the machine is
turned on.
Then the cutting plotter is ready to work.

Step 9
Use the reverse steps to remove the media.

4.2 Tracking Performance

In order to achieve the best tracking performance for a long plot, we recommend some
significant media loading procedures described as follows:

If the media length is less than 4 meters, leave the margin of 0.5mm—25mm in the left and right
edges of the media (Figure 4-12).

If the media length is greater than 4 meters, leave at least 25mm margin on the left and right
edges of the media (Figure 4-13).

Figure 4-12

Pinch rollerPinch roller

0.5mm - 25mm0.5mm - 25mm
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Please refer to the paragraph “4.5 How to Make A Long Plot” for more details.

Figure 4-13
> or = 25mm> or = 25mm
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4.3 Cutting Force and Offset Adjustment

Before sending your designs for cutting, you may perform a “cut test” to generate satisfactory
cutting results. The “Cut Test” should be repeated until the appropriate cutting conditions for the
media are discovered.

After sizing the media, press [CUT TEST] button to select the “square cut”, and press [ENTER
KEY] to confirm.

The default cutting force and offset value of the cutting test are 80gf and 0.275mm respectively.
Press [ARROW KEY] to move the tool carriage to the position where you like. Then, press the
[ENTER KEY] to perform Cut Test.

Note: At the same time, the new origin is also set at the cutting test position.

When the cutting test is completed, a pattern appears. Peel off the pattern to see if it can be
easily separated from the media base. If yes, the setup tool force is appropriate. If not or cut
through the back paper, press [FORCE KEY] to adjust the tool force until an optimum force is
obtained (Figure 4-14).

If the pattern appears to be BB or CC layout,
press [OFFSET KEY] to adjust the offset
value until AA pattern discovered.

S q u a r e C u t

Press ENTER_KEY

AA CCBB

Press ENTER_KEY

E n t e r:O KS e l e c t :

M o v e t t ec u
X Y: :

Ms t

S q u a r e C u t

Press SPEED_KEY,
FORCE_KEY,

OFFSET_KEY to setup
or

Press arrow keys to
desired position for next

square cut

E n t e r:O K
C o n t

/N : O O F FN

Machine

3mm

80
 m

m

3mm

80
 m

m

Press ENTER_KEY

80
 m

m

Finish square cut

Press
ENTER_KEY

Press ON/OFF
line_KEY

i n o u s
L NI E

Figure 4-14
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4.4 How to Cut 3mm Letters

To obtain good quality output, narrow media is recommended. However, if wide media is used,
you should:

1. Position two pinch rollers as close as possible to both edges of the cutting area.
2. Make sure the loaded media is held flat with equal tension across the platen.
3. Suggested operation settings:

Tool force: 55 gf. (or depending on the material)
Cutting speed: 45-50 cm/sec
Tool up speed: 45-60 cm/sec
Smooth cut: Disable
Quality: Small Letter

4.5 How to Make a Long Plot

When you are making a long plot with a roll of heavy and wide vinyl, paper you need to use the
“AUTO UNROLL MEDIA” function. The following parameter settings are to help users get the
best cutting quality. The actual output quality may vary when using different kind of materials

1. If the length of graphic is between 3m and 5m, the cutting speed is
better slower than 72cm/sec and the cutting quality is set as Normal.

2. If the length is longer than 5m or if the material type is difficult to cut, it is
better to further slow down the cutting speed.

3. After loading the roll media all pinch rollers are raised at this stage,
flatten the media on the platen and hold the front edge of the roll media
firmly (Figure 4-15).

Figure 4-15
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Then turn the roll downward to make an equal tension across the media
(See Figure 4-16)

4. Engage pinch rollers.
5. Fixes roll media guide bushes on the roll holder to secure the roll media.
6. The protrusion length of the blade should be longer than the thickness of the vinyl.

(Please check the “Blade Specification: About the Tool” in Appendix.) After you
notice all the above, you’ll enjoy your gigantic signs production!

4.6 When Completing the Cutting Job

After completing the cutting job, raise the sheet-loading lever, and then remove the material. You
can also cut off the finished job by the Safe Blade (a standard accessory) along the knife guide.
(Figure 4-17). Or move the carriage to the position you want to cut off the material and then
press the “CUT OFF” button on the control panel. The material will be cut off automatically.

Make sure that the media
tension is equally distributed
from left to right. If the media
is not tight enough against the
platen, it will cause tracking
problems.

Figure 4-16

Figure 4-17
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4.7 RX II-Creasing Print Driver setting

4.7.1 RX II-Creasing Print Driver setting > Option Page

Setting: You can adjust the following settings, depending on your application or results you
would like to achieve.

Quality:
[Slower speeds / higher quality - Faster speeds / lower quality]
The Cutting Quality setting function allows you to adjust and balance vector mode’s quality and
speed settings based on your specific job. Draft Mode offers the highest output speed,
sacrificing quality. Whereas Small letter Mode offers the highest quality, sacrificing output speed.
Keep in mind that speed and quality are usually at a tradeoff.

Blade:
Choose the blade type used for this job.

Use Plotter Setting:
The parameter settings will be set according to those set from the control panel.
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Back to home:
The carriage will return to the original position when this option is selected.

Auto Cut off:
This feature allows users to set the cutter to cut off the media after the completion of each job
making it easy to set up an unattended workflow for mass production. The material will be cut off
automatically once you click the Auto Cut off function on GCC driver and set the distance
between the cutting image and the cut off line.

The default is 10mm meaning the material will be cut off after 10mm of the image. The value for
the cut off function is adjustable. You can set the value between 0mm-100mm depending on
your need.

Vector Function
1. Normal:
This is the default Vector Function setting. The cutting order depends on the order of the
graphics created in the application software.

2. X sorting:
The cutting order is based on the next closest object on the x-axis from the origin.
The cutting order of the sample below will be 1,2,3,4 (please refer to figure 4-20).

2 1

3

4

Figure 4-19
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3. Inside Out Cutting:
When performing a vector cutting job in which your image has one vector cut area enclosed
within another vector cut area, select the Inside-out Sorting mode. This mode will
automatically instruct the print driver to process the inside vector image and moving
outwards. This setting will always automatically direct the cutter to cut from the inner most
vector shape and move outwards.

4. Cutting Path Optimization:
This is a setting that will minimize your process time. When selected, the print driver will
analyze your image and automatically determine the most efficient processing path to
process your image.

5. Section Cutting:
Users can output long picture by section cutting which could make cutting more stable and
get superior cutting quality. Users can set the section by registration marks or input the value
manually. When cutting plotter finishing cutting in section 1, it will continue to cut in section 2.
The picture is shown as below:
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File Function (Option Page):
The file function section allows you to manage various cutter parameters. This section is useful
when performing repeated jobs on a variety of objects, allowing you to save your frequently used
cutter parameters and load them in the future.

• Custom Media: This section lists the files for the parameter settings that you have recently
created and worked. You can save more than 50 files to simplify your cutting job.

• Default: This section contains the reference settings that are applicable with the verified
materials to achieve the best cutting results. Please note that the setting value might need to
be adjusted according to different suppliers of materials.

• SAVE: This function will save current print driver parameter settings to a file under the
specified location on your computer. (Saved parameter setting files will be tagged with the RX
II series extension)

• LOAD: This function allows you to load previously saved print driver parameters.

• ORIGINAL: This function will load the print driver’s original factory parameter settings.

• SAVE TO DEFAULT: This function allows you to save your current print driver parameters as
the default startup settings.

• DELETE: This function will delete the file you select from the Custom Media section, whereas
the settings in Default section cannot be deleted. Please note the delete function only removes
the file from the Custom Media section, it does not remove the .RX file from your hard drive, if
you wish to completely remove the file from your hard disk, and you will have to manually
delete the file from your operating system.

Note:
If you are using Windows 2000 or XP as your operating system, then make
sure you login with an administrator or administrator-rights account in order
to properly save cutter parameter settings.
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4.7.2 RX II-Creasing Print Driver setting > Creasing Page

The RX II series incorporates the use of 16 different colors to represent 16 different parameter
settings including cutting speed, force and blade offset settings when cutting. These colors are
referred to as “Tools”. Think of each color as a designated cutter setting, rather than as a color.
An image that is made up of black, red and blue colors will be processed using the cutter
settings designated for each particular color. In order to utilize up to 16 different colors (cutter
parameter settings), make sure your graphics software can recognize and utilizes the 16 colors
designated by the GCC RX II series print driver (please refer to figure 4-21).

Figure 4-21

If you would like to specify your own colors to designate to a particular cutter setting, then all you
have to do is to double-click on that particular color from the creasing menu and a color manager
window will open where you can select “define custom colors” to define your own color (shown in
the picture below). This is useful when your image is composed of colors that are not part of the
creasing menu’s default color selection, and instead of modifying your image, you simply would
like to assign the cutter settings based on the existing colors from your current image.

Note:
The GCC RX II series driver cannot store more than 16 colors or different
cutter parameter settings per file.
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You should set the RGB color code in the graphic design software such as CorelDRAW and
Adobe Illustrator as same as Creasing page of print driver. That makes cutting plotter cut in
right parameters. Please follow the step-by-step instruction blow.

1. Double-click the color you want to define, and press “Define Custom Colors”
button.

2. Remember the RGB code.

Figure 4-22



RX II Series User Manual

Operation 4-17

3. Open the Outline Pen Color, Click “More…” in the CorelDRAW and select RBG or
open Color Picker in the Adobe Illustrator.

CorelDRAW

Adobe Illustrator
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4. Set the RGB code in the CorelDRAW or Adobe Illustrator as same as Print driver
that makes cutting plotter cut in right parameters.

CorelDRAW

Adobe Illustrator
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Speed (Creasing Page) [DEFAULT SETTING: 72cm/sec]
The speed slider controls the cutter’s cutting speed during operation with a range setting from
3 – 153cm/sec. The GCC RX II series maximum cutting speed is 153 cm (60 inches) per
second.

Force (Creasing Page) [DEFAULT SETTING: 80g]
The force slider controls the cutting force during operation with a range setting from 0 – 600g.

Offset (Creasing Page) [DEFAULT SETTING: 0.25mm]
The offset slider controls the blade offset depending on the blade you used.

Die Cut (Creasing Page)
The Die Cut function can allow you to cut through the backing of the material. You can only use
the first 8 color for this function. If you choose Color No.1 and click the Die Cut function, the
Color No.9 will become Color No.1* for setting different parameter for the same cutting line.
(Figure 4-24)

You can adjust the parameter such as force and length in both Color No.1 and Color No. 1* as
you need.

Figure 4-24

Figure 4-23
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For example:

Image Scaling (Creasing Page)

The Image Scaling function can allow you to set the image scale of media length and width to
decrease the difference between the actual length and the ideal length caused by various media
used while processing cutting job.

Color No.1: Cutting through the vinyl only

Color No.1*: Cutting through the backing of the
material

Figure 4-25

Figure 4-26

Sticker
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4.7.3 RX II-Creasing Print Driver setting > Paper Page

Paper Size (Paper Page) [DEFAULT SETTING: Y = the width of machine; X will be
automatically set to be twice the length of Y]

The paper size represents your total work area. The X value represents the length and the
Y value represents the width. The paper size should be set as the same as your image so you
can get a better cutting quality.

Unit (Paper Page) [DEFAULT SETTING: Metric (mm)]
Here you can set your preferred measurement standard in which you would like use with the RX
II series print driver. You can choose between metric or imperial standards.
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4.7.4 RX II-Creasing Print Driver setting > Paper Feeder Page

The setting in Paper Feeder Page works when 2-point positioning registration mark setting is
applied in a cutting file. Please refer to A-4 Add Two Point Registration Marks section or A-5 Add
Two Point Registration Marks section.

• Repeat count: to define the number of copies desired in one cutting job

• P3 (X,Y) / P4 (X,Y): to set offset X and Y value (Horizontal line is defined as Y and vertical is
defined as X when facing the cutting plotter).

When the actual cutting line and the printed line need to be changed towards the direction of P1
mark, then simply add the negative value of the offset. If the direction is from the opposite of the
P1 mark, then enter positive values for the offset. This method applies to both X and Y axes
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4.8 How to create a file for cutting with barcode function

The barcode function allows the association of barcode graphics with cutting files. By adding barcode
graphics to the cutting file, the plotter can automatically perform cuts based on the information
encoded in the barcode. This is particularly useful for batch cutting or cutting tasks with specific
requirements, as it provides higher efficiency and accuracy

1. Import the image you want to cut.

2. Go to Tools -> Scripts -> Run Script…
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3. Select “GlobalMacros (GCCAASII_Draw.gms)" and select Run.

4. The “AASII Reg. Mark Setting” window will pop-up. Tick the Check box and click Apply.

Note:
Make by page size: to generate barcode by page.

Generate barcode (3~12 digit numbers): a barcode will
be generated associated with the numbers being
entered. Please note that the barcode number must
be the same as the name of the cutting file.

Generate barcode at both ends: to generate barcodes
at both ends of the image.
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5. The barcode will be generated.

6. Go to “Save As...” option in the File menu and choose the preferred file format for printing. Print the
file using your printer to prepare it for later cutting.
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7. Go to “Print...” option in the File menu or click “Print” to open the Print window to save the cutting
file for cutting with barcode function.

8. Navigate to “Layout” tab to set the Reposition artwork to Bottom left corner.
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9. Go to “General” tab and check the “Print to file” option, then click Print.

Note: make sure the file name is the same as the number of the barcode in step 4.
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10. Open SmartCUT. Designate the folder location to set the directory and click OK.

All files being saved for cut with barcode function in this hot folder will be displayed.
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11. Set the communication port and click OK.

12. Load the printed media. Click on Scan icon to start barcode detecting and cutting.
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Note:

If you add a new file to the hot folder, click the 'Refresh' button, and the newly added file will be
displayed."

If there are any errors, the details will be shown in the Error Messages box

Note:
If the machine does not respond, reboot the machine to restore the operation.
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4.9 Reference Parameter setting for different materials

The following reference parameter is used on GCC verified materials shown in the table.

Material
Personalized/ Wall

stickers
Vehicle stickers Window decoration Window tint

Blade red red red red / yellow

Blade tip length (mm) 0.28 0.27 0.25 0.09

Force (g) 105 85 95 70

Speed (cm/sec) 72 60 65 72

Offset (mm) 0.25 0.25 0.25 0.25

Recommend model
RX, Jaguar, Puma,

EX, AR

RX, Jaguar, Puma,

EX, AR

RX, Jaguar, Puma,

EX, AR

RX, Jaguar, Puma,

EX, AR

Material Stencil Reflective film Flock Cardboard

Blade red / green green green green

Blade tip length (mm) 0.3 0.5 0.3 0.3

Force (g) 180 380 135 165

Speed (cm/sec) 15 3 30 30

Offset (mm) 0.25 / 0.5 0.5 0.5 0.5

Recommend model
RX, Jaguar, Puma,

EX, AR

RX, Jaguar, Puma,

EX

RX, Jaguar, Puma,

EX, AR

RX, Jaguar, Puma,

EX, AR

Material Magnets Protective tint Rhinestone Sandblast mask

Blade green green green blue

Blade tip length (mm) 0.8 0.3 0.8 0.27

Force (g) 580 320 190 85

Speed (cm/sec) 3 3 15 60

Offset (mm) 0.5 0.5 0.5 0.25

Recommend model RX, Jaguar
RX, Jaguar, Puma,

EX
RX, Jaguar, Puma

RX, Jaguar, Puma,

EX, AR

Material Small text (vinyl)

Blade black

Blade tip length (mm) 0.27

Force (g)
thick: 150

thin: 90

Speed (cm/sec) 9

Offset (mm) 0.175

Recommend model RX, Jaguar, Puma
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Chapter 5 Automatic-Aligning System

Please note that this chapter is only an instruction to AASII; for step-by-step instructions, please refer to
the following chapters: 08_A-3 CorelDraw Plug-In, 08_A-4 Illustrator Plug-In, 08_A-5 GreatCut Plug-In.

5.1 Introduction

The RX II series cutting plotters feature a standard Automatic-Aligning System (AAS II) to guarantee
precise contour cutting quality by detecting the registration marks printed around the graphic.

Notice
n Avoid any kind of light source horizontally illuminating the AAS module.

- PROHIBITED - ACCEPTABLE

n DO NOT take off the cover of AAS module while in operation.

- PROHIBITED
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5.2 AAS Contour Cutting System

The AAS system has one calibration procedures to ensure maximum accuracy of AAS operation. To
operate the AAS you need to learn about the method of media feeding firstly. (Refer to 4.1 Media
Loading.)

5.2.1 Notice for Registration Marks

The first registration mark is designed to be different in order to identify the origin for AAS
auto-detection. The following precaution must be aware for registration marks to be read
automatically.

n Type of media
n Registration mark pattern
n Reading range required for detection the registration marks
n Position for registration marks and medium

The registration marks have to be:
n Created by cutting software like GreatCut or GCC CorelDRAW plug-in
n In black color (printing quality of registration marks is essential; incorrect, misaligned

colors, blurry or smeared printout might leading to inaccurate cutting result)
n Length: The length of marks

à Range: 5mm~50mm
à Optimized Setting: 25mm

n Thickness: The line thickness of marks
à Range: 1mm~2mm
à Optimized Setting: 1mm

n Margin: The distance between marks and images
à Range: 0mm~50mm
à Optimized Setting: 5mm

The cutter can not detect the marks while:
n Cutter carriage is not located near the outside area of first mark before detecting (See

the picture in page 5-7 for auto-detecting area of first mark.)
n Medium thickness is more than 0.8mm
n Transparent medium is used
n Non-monochrome drawing. The marks can’t be read if is printed on colored medium
n Dirty or creased medium surface
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5.2.2 AAS II on RX II series

There are three types of AAS II mark patterns: 4-Point Positioning, Segmental Positioning, and
Multiple Copies. Note that before print out your designs by inkjet printers, the registration
marks have to be created on your graphic designs by cutting software like GreatCut, SignPal or
GCC CorelDraw plug-in. Hand-made marks or drawings won’t be reorganized by GCC cutting
plotters. For more details about registration mark setting in cutting software, please refer to
appendices for detailed instruction.

1. 4-Point Positioning
This is the basic mark pattern that AAS II will auto detect four registration marks and contour cut
images inside those marks.
n Command: Esc.D1;(XDist);(YDist):
n Layout: 4 registration marks at the 4 corners around the design

2. Segmental Positioning
In addition to 4 original points, the intermediate registration marks are added on both X axis and Y
axis to help contour cut accurately, especially for cutting large images.
n Command: Esc.D2;(XDist);(YDist);(XStep);(YStep):
n Layout:

In-between distance on X: 200~600mm, default 300mm
In-between distance on Y: 200-600mm, default 300mm
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n High Precision Long Picture Cutting

RX II series performs section cutting to enhance output qualities.
lThe object will be output following the section pattern based on the Segmental

Positioning parameters.

lCutting sequence: Section1-> Section 2-> Section 3- > Section 4

3. Multiple Copies
The function is used to duplicate images to let you cut quantities of images at a time. The AAS II
sensor will automatically scan registration marks for each individual image to ensure the contour
cutting precision.
n Command: Esc.D3;(XCopies);(YCopies);(Space):
n Layout:
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5.2.3 5.2.3 Automatic Distinction of the Plot Direction

For the convenience of users, RX II series automatically detects the feeding direction of the

material when performing contour cutting. Figure 5-1 shows the Registration Mark detection

sequence when the material is fed in the standard way (1->2->3->4) while Figure 5-2 is how RX II

series detects registration marks (3->4->1->2) when the material is reversely fed. RX II series is able

to detect registration marks and performs contour cutting however users feed the media.

Direction detection steps:
(Please see Figure 5-2)

a. Detects the position of the 3rd Registration Mark

b. Proceeds to the 4th Registration Mark to detect the direction

(The direction detection procedure will be performed by the detection of 4th Registration Mark)

c. The information is reflected in the driver and recalculated before output

d. The registration mark detection and object output process is implemented

(Registration Mark detection
sequence: 3->4->1->2)

Figure 5-1 Figure 5-2
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5.3 Printer Test

Before performing AAS contour cutting, it’s recommended to print out a test file to make sure
the AAS II cutting accuracy. Please visit GCC website and go to Download Area to download the
test files.
https://www.gccworld.com/download.php?act=view&id=20

There are two testing files for AASII:
1. AAS II_X_Y_Offset_Caberation_A4 .eps (A4 size)
2. AAS II_X_Y_Offset_Caberation_600_600 .eps (Default setting, it is recommended for

testing)

n Print out the testing graphic. ( Please use high precision printer)
n Load the graphic to RX II series and sent the file to test the cutting job
n If there are any adjustments to be made, you can change the offset value by following

the steps:
■Measure the offset values from the printed line and the actual cutting line.
■ Enter the AAS Offset under MISC function for the values you just measured, then

press Enter
■ Test the cutting again
■ AAS II offset X and Y value is defined as following:

Horizontal line is defined as X and vertical is defined as Y (when facing the cutting
plotter)

https://www.gccworld.com/download.php?act=view&id=20
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■When the actual cutting line and the printed line need to be changed towards the
direction of origin mark, then simply add the negative value of the offset. If the
direction is from the opposite of the origin mark, then enter positive values for the
offset (see the following figures). This method applies to both X and Y axes.

Note:
n Before adjusting the AAS II settings, please proceed scaling for width and length.
n The blade offset value isn’t set for this test graphic, please set it according to the

blade you use.
n If you have any question, please contact us or your local distributor for assistance.
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5.4 Registration Mark Offset Range

Please correctly load your media (refer to the alignment ruler on the platen) to make sure the
registration marks are successfully detected. Deviation exceeds the range below will lead to detection
failure.

5.5 Contour Cutting

For accurate contour cutting with AAS function, please proceed the following steps:

Step 1 Creating Graphics
■ Create the graphic that you want to print and cut in your software.

■ Create a contour for cutting around the graphic.

TIPS1: Leave some space between the graphic and contour line.
TIPS2: Create the contour in a separate layer and assign a different color for it.

■ Add registration marks around the graphic.

Note:
The Multiple Copies function is also available. It automatically copy the graphic and
registration marks.
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Step 2 Placing the Registration Marks
n The AAS Layout Instruction:

* Auto-detection function on the 1st mark covers the grey area
n Suggested 30mm margin on both left and right sides of media sheet.
n Suggested 20~30mm margin on top of media sheet, and at least 50mm margin on the
bottom edge to prevent sheets dropping or any error occurred while media sizing.

Step 3 Print the Graphics
■ Print the graphic and the marks with your printer

(Scaling = 100%).

■ When printing on a roll media, make sure the orientation as following:
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Step 4 Load the printout onto cutter
■ The Origin Mark is is different from the rest registration marks. Please make sure the

media is fed with correct direction.

Step 5 Cut the Contour
■ Send out the command from software to perform the contour cutting job.

5.6 Tips for AAS

For getting better results of contour cutting, there are some tips below for your reference.

n Keep light sources simple and avoid illuminating from the sides of cutter.
n Before operating AAS, change the maximum paper size in RX II series driver property.

Step 1 Find the RX II model in the “Printer & Fax” folder of your PC.
Step 2 Open the Properties window and select the “Paper” tab.
Step 3 Change the maximum Paper Size of X to 1200mm.

n Adjust the cutting speed to between 300~600mm/sec.
n Avoid the registration marks locating on the tracks of pinch rollers.
n Make sure the edge of the media is not bent up when detecting registration marks.
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Chapter 6 Maintenance

This chapter explains the basic maintenance (i.e. cleaning the cutting plotter) required for the cutting
plotter. Except for the procedures mentioned below, all other maintenance must be performed by a
qualified service technician.

6.1 Cleaning the Cutting Plotter

Cleaning the machine properly and regularly will ensure optimal performance out of your machine.

Cleaning Precaution!

Recommended Methods:
l Gently wipe the cutting plotter surface with a lint-free cloth.  If necessary, with a damp cloth

immersed in water or alcohol. Dry and wipe any remaining residue off a soft, lint-free cloth.

l Wipe all dust and dirt from the tool carriage rails.

l Use a vacuum cleaner to empty any accumulated dirt and media residue beneath the pinch roller
housing.

l Clean the platen, paper sensors and pinch rollers with a damp cloth immersed in water or alcohol,
and dry with a soft, lint-free cloth.

l Wipe dust and dirt from the stand.

l Unplug the cutting plotter before cleaning it
in order to prevent electrical shock.

l Never use solvents, abrasive cleaners or
strong detergents for cleaning. They may
damage the surface of the cutting plotter
and the moving parts.



RX II Series User Manual

Maintenance 6-2

6.2 Cleaning the Grid Drum

1. Turn off the cutting plotter, and move the tool carriage away from the area needed to be cleaned.

2. Raise the pinch rollers and move them away from the grid drum for cleaning.

3. Use a bristle brush (a toothbrush is acceptable) to remove dust from the drum surface. Rotate the
drum manually while cleaning. Refer to Figure 6-1.

6.3 Cleaning the Pinch Rollers

1. If the pinch rollers require a thorough cleaning, use a lint-free cloth or cotton swab to wipe away the
accumulated dust from the rubber portion of the pinch rollers. To prevent the pinch rollers from
rotating while cleaning, use your finger to hold the pinch rollers to prevent them from rotation

2. To remove the deeply-embedded or persistent dust, use the lint-free cloth or cotton swab
moistened with rubbing alcohol.

Figure 6-1

Note: The daily maintenance of your cutting plotter is very important. Be sure to
clean up the grid drum and pinch rollers regularly for better cutting accuracy
and output quality.
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Chapter 7 Trouble Shooting

This chapter is to help you correct some common problems you may come across. Prior to getting into
the details of this chapter, please be sure that your application environment is compatible with the
cutting plotter.

Possible Causes:

7.1 Non-Operational Problems

Check the following first:
n Does the AC power cord plug in properly?
n Does the AC power cord connected to the power connector properly?
n Does the power LED still illuminate?

Solutions:

If the LCM is able to display the message, the cutting plotter should be in a normal condition.
Switch off the cutting plotter and turn it on again to see if the problem still existing.

If the LCM is not able to display any message, contact the technician from your dealer.

Note:
Before having your cutting plotter serviced, please
make certain that the malfunction is in your cutting
plotter, not the result of an interface problem or a
malfunction in your computer or a software problem.

Why is the cutting plotter not functioning?
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7.2 Operational Problems

Some mechanical problems or failure during operation will cause some problems. The error messages
shown on the LCM present the problem first, and followed by recommended actions. If the problem still
exists after the recommended actions have been done, have your cutting plotter serviced.

Error, Check Media
Or Drum or X Motor

This message indicates that there might be a
problem on the X axis. Check if the drum is
working well and if the media is well loaded.
Correct the problem and re-power on to
reboot system.

Error, Check Media
Or Y Motor

This message indicates that there might be
an obstruction to carriage relating to a
problem on the Y axis.  Correct the problem
and re-power on to reboot system.

Error, Check Carriage
Sensor or VC Motor

This message indicates that the blade
up/down sensor malfunction. Re-power on to
re-boot system. If the problem still exists, find
a serviceman.

Graph Was Clipped.
Data In Buffer

This message indicates that the cutting
exceeds the cutting limit. Reload larger media
or re-scale the plot to a smaller size; then
press the key followed by the display of LCM
to continue.



RX II Series User Manual

Trouble Shooting 7-3

7.3 Cutting Plotter/Computer Communication Problems

The messages showed below present problems in relation to cutting plotter/computer communication.

Communication Error
Setup: MISC. key

Is the connection cable
connected to the cutting plotter
and computer properly?

Yes No

Has the interface setting
been done correctly?

Refer to Chapter 2 -
Connecting your cutting
plotter.

Yes No

Try the communication
between your cutting plotter
and computer. If it still does
not work, have your cutting
plotter serviced.

Refer to the “MISC” key in
Chapter 3 - Description of
Operation for the port setup.

If your cutting plotter can not recognize
the HP-GL/2 or HP-GL commands, please
check the HP-GL/2 or HP-GL commands
applied to your cutting plotter are used
properly.

Note:
The computer also needs to set up compatible communication
parameters to the cutting plotter set up.

HP-GL/2 Cmd. Error
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7.4 Software Problems

Check the following first:

Does your software package indicate that it will work with
your computer and cutting plotter?
Does your software support HP-GL and HP-GL/2 drivers?
(* check the configuration settings of your software.)

Yes No

Does the cutting plotter interface
match the requirements of your
software?

Does your
software
recommend
using a different
cable?

Does the software
vendor provide a
sample file?

Most well known cutting softwares
in the world have drivers for our
cutting plotters. If not, use
software that has HP-GL and
HP-GL/2 emulation supports and
you can chose the following three
drivers:
l A3 size: HP7475A
l A1 size: HP7580A
l A0 size: HP Draf Pro Exl or

HP Draf Master

Yes No

Refer to Chapter
2 - Connecting
your cutting
plotter.

Yes No

Try using the
recommende
d cable.

Yes No

Re-power on the
cutting plotter and
try to send the file
again.

Do something about the
error message display on
LCM, or consult your
software vendor.
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7.5 Cutting Quality Problems

Is the blade installed correctly and the blade
holder fastened securely?

Yes No

Is the blade dull
or chipped?

Yes No

Replace
with a new
blade

Is tool force set up
properly? (The default
for tool force is 80 gf)

Yes No

Adjust the tool force to obtain an
optimum blade force. Refer to
Chapter 4.3 “Cutting Force and
Offset Adjustment”

Is the tool offset set up
properly?

Yes No

Adjust the tool offset to
obtain an optimum value.

Is there any dirt adhered to
the blade?

Yes No

Refer to Chapter 2.4
“ Blade Installation”

Remove the blade
and clean it.

Please contact your dealer for technician
support.

Note: The daily maintenance of your cutting plotter is very important.
Be sure to clean up the grid drum and pinch rollers regularly for
better cutting accuracy and output quality.
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RX II series Specification

Model Number
RX II-61

(Creasing)
RX II-61 RX II-101S RX II-132S RX II-183S

Operational Method Roller-Type

Max. Cutting Width 536mm (21”) 610mm (24”) 1010mm (40”) 1320mm (52”) 1830mm(72”)

Max. Cutting Length 50m (164ft)

Max. Media Loading Width 642mm (25.28”) 810mm(31.88”) 1326mm(52.2”) 1635mm(64.37”) 2145mm(84.44”)

Min. Media Loading Width 50mm (1.97in)
Number of Pinch Rollers 2 3 4 5

Acceptable Material Thickness 0.8mm (0.03in)

Drive Motor DC Servo Control

Cutting Force 5~600 g

Max. Cutting Speed 1530 mm/sec (60 ips) (at 45° direction)

Acceleration 4.2 G (gravity)

Offset 0~1.0 mm (with an increase of 0.025mm)

Memory Buffer 32 MB /16 MB (when using AAS)

Interfaces USB 2.0 (Full Speed), Serial (RS-232) and Ethernet

Type of Command HP-GL, HP-GL/2

Mechanical Resolution 0.006 mm

Software Resolution 0.025 mm

Distance Accuracy ±0.254 mm or ±0.1% of move, whichever is greater

Repeatability ±0.1mm

Automatic-Aligning System Completely Automatic Contour Cutting System for print to cut solution

Curve & Arc Smoothing Yes

Configurable Origin Yes

Test Cut capability Yes

Tangential mode Yes

Over Cut Yes

Repeat Yes

Copy Yes

Pouncing Yes

Control Panel LCD (20 digits x 2 lines), 15 Keys, 1 Power LED, 1 Green LED

Diameter of Blade 2.5 mm

Power Supply 100 ~ 240VAC 50/60Hz (auto switching)

Power Consumption 251.8 watts

Dimension (HxWxD) mm 437 * 1098 * 479 1147 * 1614 * 651 1147 * 1923 * 651 1147 * 2433 * 756

(HxWxD) in 17.2 * 43.2 * 18.8 45.2* 63.5 * 23.8 45.2 * 75.7 * 23.8 45.2 * 95.8 * 29.8

Net Weight 25.5kg 25kg 61.8kg 71.5kg 72kg

Auto Cut Off Standard

Max. Cut Off Width 642mm 696mm 1107mm 1417mm 1927mm

Stand Optional Standard

Media Basket Optional

Operation
Environment

Temperature 15°C~30°C / 60°F~86°F

Humidity 25% ~ 75%
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l Compatible with Windows 7 and above & MAC OS X 10.6 and above.

l The specification and data sheet may vary with different materials used. In order to obtain the best output quality, please

maintain the machine regularly and properly.

l GCC reserves the right to change the specifications at any time without notice.

l GCC certified material in tracking is Avery MPI 3000.

l The above listed specification values are effective only when operated with media certified by GCC.
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Blade Specification

265019700G

For cutting thick fluorescent and window tint film. Also for cutting
detailed work in standard vinyl.

The blade is 45° with Red Cap, 0.25 mm blade offset, and 2.5 mm
blade diameter.

265017540G

For cutting reflective vinyl, cardboard, sandblast, flock, and stencil
sharp edge.

The blade is 60° with Green Cap, 0.50 mm blade offset, and 2.5 mm
blade diameter.

265017550G

For cutting thin sandblast mask and stencil. The blade with sharp
angle and special design, allowing it to maneuver around sharp
corners.

The blade is 60° with Blue Cap, 0.25 mm blade offset, and 2.5 mm
blade diameter.

265017560G

For cutting small text and fine detail. Sharp blade with smallest offset.

The blade is 50° with Black Cap, 0.175 mm blade offset, and 2.5 mm
blade diameter.

265017530G

For thin and delicate media such as window tint.

The blade is 25° with Yellow Cap, 0.25 mm blade offset, and 2.5 mm
blade diameter.
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About the Tool

A generic term referring to the blade that cuts the sheet, the pen that does plotting, and the LED
bombsight (option) used for pointing to the reference point.
OFFSET is the distance that the blade tip is displaced from the centerline of the blade.

Protrusion Length of the Blade

Length of protrusion = t1 + t 2/ 2, but for your convenience you may just make it about 0.3mm ~
0.5mm beyond the blade holder tip.

Central line

Blade

Blade tip

offset

Thickness of the
base paper (t 2)

Thickness of
the media (t1)

Protrusion length
of the blade
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CorelDRAW Output Instruction
The following is an example of how to output the file with CorelDRAW.

User Instructions

1. Open CorelDRAW, finish editing all the files you wish to plot and select all the images at once.

2. Select “Outline Pen” to adjust the outline for cutting.

3. Adjust the value of pen width to 0.001 mm and click “OK” to save your input.
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4. Select “ File→ Print” to output the file to your cutters.

5. Choose the correct model you have installed.
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6. Choose the “Layout page” and click the “Reposition images to: → Bottom left corner”. Please
note that you must put your image at the bottom left corner.

7. Go back to the General page and check that your image is at the bottom left corner. Click “Print”
and get a wonderful cutting image.
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CorelDRAW Plug-In Instruction

AASII VBA Installer is applicable for CorelDRAW Version 13, 14, 15, 16, 17, 18

Installation
Please refer to Step 8 in Chapter 2.7.1.2 Driver Installation to install AAS plug-in for CorelDRAW.

Run CorelDRAW AAS Plug-in

Step 1 Run CorelDRAW to edit your graphics and select all images at once when you wish to plot.

Step 2 Select “ToolsàMacrosàRun Macro.” Then select Global Macros (GCCAASII_Draw13.gms) under
the “Macros in” manual, and press “Run”.
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Step 3 Click on “Apply” and select whether you would like to add the registration marks by page size or
by object.

Step 4 Now you can print out the image file with registration marks.

You can also add a Hot Icon for the AAS Plug-in

Select “Toolsà OptionsàWorkspaceà Customizationà CommandsàMacrosà
GCCMadual.GCC_AAS_Plug_In” and Click OK.

Note: “Add Registration Mark by Object” will be the default selection if you click on
the image whereas “Add Registration Mark by page size” will be the default one
when the blank area on the page is clicked.
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Add Registration Mark by page size

If you tick “Add Registration Mark by page size” as shown in the figure below and click “Apply”, your
registration marks will be created automatically (please see Figure A3-1).

The system will create the 4 marks on the 4 corners of the page as shown in the picture below
wherever you move your image.

Figure A3-1

Figure A3-2

Figure A3-3

Note:
1. The length setting will be in the range of 5-25mm

according to your page size.

2. Please DO NOT make any changes to the “Origin”
section when you choose to add registration marks by
page size as indicated below otherwise the position of
the marks will be changed (please see Figure A3-2).
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Workable area
It allows users to edit and cut graphics in the area outside the registration marks when adding
registration marks by page.

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on left and
right sides and 4.5mm extended from the registration mark on top side. On the bottom side, it is
suggested to leave at least 25mm margin from the edge of media sheet to prevent sheets dropping or
any error occurred while media sizing.

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the left
side, 9mm extended from the registration mark on the right side and 11mm extended from the
registration mark on top side. On the bottom side, it is suggested to leave at least 25mm margin from
the edge of media sheet to prevent sheets dropping or any error occurred while media sizing.

Note: Select “Edge” mode when media sizing to allow the media sheet to be unrolled.
If you select “Single” mode, the media sheet will not be able to be moved back and
hence fail to be detected by front paper sensor.
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Add Registration Mark by Object

If you tick “Add Registration Mark by Object”, you will be offered three options of registration marks as
shown below. 4-Point Positioning

l Length: The length of marks

à Range: 5mm~50mm

à Optimized Setting: 25mm

l Thickness: The line thickness of marks

à Range: 1mm~2mm

à Optimized Setting: 1mm

l Margin: The distance between marks and images

à Range: 0mm~50mm

à Optimized Setting: 5mm

Segmental Positioning

l X Step: The distance of intermediate position on the X axis

l Y Step: The distance of intermediate position on the Y axis

à Range: 200mm~600mm

à Optimized Setting: Less than 500mm

Multiple Copies

l No. of X Copies: The numbers of copies on X axis

l No. of Y Copies: The numbers of copies on Y axis

à Range: 1~50. (The more copies you make, the more time

is needed for data transmission.)

à Numbers of X Copies * Numbers of Y Copies = The total

amount of image copies

l Copies with outline：To show outlines of image graphics

Figure A3-4

Note: The values entered in the “4-Point Positioning” section (length, thickness and
margin) will still be applied when you tick “Segmental Positioning” or “Multiple Copies”.
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4-Point Positioning

The system will create the 4 marks as shown in the picture below.

4-Point Positioning

l Length: The length of marks

à Range: 5mm~50mm

à Optimized Setting: 25mm

l Thickness: The line thickness of marks

à Range: 1mm~2mm

à Optimized Setting: 1mm

l Margin: The distance between marks and images

à Range: 0mm~50mm

à Optimized Setting: 5mm

Figure A3-5

Figure A3-6



RX II Series User Manual

CorelDRAW Plug-In A-4

Note:
1. To save your materials, in addition to amending object margins, you can also adjust the length of

the registration marks (5mm minimum) when you apply 4-Point Positioning (see table 1 for
suggestions based on different material sizes). The smaller the size is, the smaller the distance
between the object and the registration marks is (see the figures below).

Table 1
*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so please
make sure the amount you enter is reasonable.

3. If you change the paper size, you will have to reset the registration marks otherwise the previous
setting will be applied.

Page size
(unit: mm)

Suggested mark length
(unit: mm)

A6 (105 x 148) 5
A5 (148 × 210) 8
A4 (210 × 297) 11
A3 (297 × 420) 16
A2 (420 × 594) 23
A1 (594 × 841) and above 25*

Area to be cut

Figure A3-7 Figure A3-8



RX II Series User Manual

CorelDRAW Plug-In A-4

Segmental Positioning
For precise cutting quality, it is suggested to select “Segmental
Positioning” when you are working on an extra long or large-sized
image to increase cutting accuracy.

Segmental Positioning

l X Step: The distance of intermediate position on the X axis

l Y Step: The distance of intermediate position on the Y axis

à Range: 200mm~600mm

à Optimized Setting: Less than 500mm

The system will create the as shown in the picture below

Segmental Positioning will be applied to Multiple Copies when the object to be copied is of large size
(with the length or width over 200mm) to increase the accuracy of registration mark detection.

Figure A3-9

Figure A3-10

Segmental Positioning
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Multiple Copies
It is suggested to select “Multiple Copies” when you would like to make several copies of one image on
your material to increase cutting accuracy.

Multiple Copies

l No. of X Copies: The numbers of copies on X axis

l No. of Y Copies: The numbers of copies on Y axis

à Range: 1~50. (The more copies you make, the more time is needed

for data transmission.)

à Numbers of X Copies * Numbers of Y Copies = The total amount of

image copies

l Copies with outline：To show outlines of image graphics

The system will create the as shown in the picture below.

X axis

Y axis

Figure A3-11

Figure A3-12
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Contour cutting through CorelDraw
Step 1 Position the paper with registration marks printed by your printer on the GCC cutter.

Step 2 Select “FilesàPrint”.

Note: if you use CorelDraw X5 and later, you must follow the steps below.

Step 1 Click the “color” page and go to the “Color conversions performed by:” and then select the
model name of you cutter (please refer to Figure A3-14).

Figure A3-13

Figure A3-14
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Step 2 Go to the “Layout” page and select Bottom left corner at “Reposition images to”.

Step 3 Click “Print”.

Figure A3-15
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Illustrator Plug-In Instruction

AASII VBA Installer is applicable for Adobe Illustrator Version CS4, CS5, CS6, CC.

Installation
Please refer to Step 8 in Chapter 2.7.1.2 Driver Installation to install AAS plug-in for Adobe Illustrator.

Printer Setting

Step 1 Go to Control Panel, right click on the printer and select Printer Properties to open the
Printer Properties page
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Step 2 Go to the Advanced page and make sure the “Enable advanced printing features” box is
unchecked.
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User Instructions

Step 1 Open Illustrator.

Step 2 Edit your image and create a contour line (Note: you must have the line width set as 0.001mm).

Step 3 Click on the image and apply the AAS function (FileàScriptsà_AASII_Plug_In).

Contour line



RX II Series User Manual

Illustrator Plug-In A-5

Step 4 Select the registration marks needed

Step 5 Three types of registration marks are introduced here: 4-Point Positioning, Segmental
Positioning and Multiple Copies.

Step 6 Confirm the registration marks (the 4-Point Position mark is used as an illustration in the
following steps).

Note:
The values entered in the “4-Point Positioning” section (length, thickness and margin)
will still be applied when you tick “Segmental Positioning” or “Multiple Copies.”
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Step 6 Confirm the registration marks (the 4-Point Position mark is used as an illustration in the
following steps).

Step 7 Click on the blank area on the page and then click “Document Setup”.
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Step 8 Hit “Edit Artboards”.

Step 9 Click on “Presets→ Fit Artboard to Artwork bounds”.
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Step 10 Please move your mouse to the tool bar on the left when step 9 is finished and then click
“Selection Tool”.

Step 11 This will take you back to the edit mode.
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Step 12 Print out the file with the contour line and the registration marks.

Step 13 Place the printed file on the cutter, lower the pinch rollers and then position the carriage at the
origin of the registration marks.

Step 14 Send the file to the cutter.
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Step 15 Select the cutter model, position the object in the bottom left corner.

Step 16 Your job is now completed.
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Add Registration Mark by page size
If you want to create registration mark by page size, select the object, go to “Scripts” under “File” and
select “_AASII_Plug_In”

Tick “Make by page size” and click “Apply” and the
registration mark will be created on the 4 corners of the page
automatically, sown as below.

Note:
The length setting will be in the range of 10-50mm according to your page size.
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Workable area
It allows users to edit and cut graphics in the area outside the registration marks when adding
registration marks by page.

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on left and
right sides and 4.5mm extended from the registration mark on top side. On the bottom side, it is
suggested to leave at least 25mm margin from the edge of media sheet to prevent sheets dropping or
any error occurred while media sizing.

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the left
side, 9mm extended from the registration mark on the right side and 11mm extended from the
registration mark on top side. On the bottom side, it is suggested to leave at least 25mm margin from
the edge of media sheet to prevent sheets dropping or any error occurred while media sizing.

Note: Select “Edge” mode when media sizing to allow the media sheet to be unrolled. If
you select “Single” mode, the media sheet will not be able to be moved back and hence
fail to be detected by front paper sensor.



RX II Series User Manual

Illustrator Plug-In A-5

Add Registration Mark by Object

If you add registration mark by Object, you will be offered three options of registration marks.

Firstly, select the graphic which you want to add registration mark on and go to “Scripts” under “File”
and select “_AASII_Plug_In”.

Make sure to untick “Make by page size” and choose one of the registration mark types whichever is
suitable.



RX II Series User Manual

Illustrator Plug-In A-5

Three types of registration marks

4-Point Positioning

The system will create the 4 marks as shown in the picture below.

4-Point Positioning
l Length: The length of marks

à Range: 5mm~50mm
à Optimized Setting: 25mm

l Thickness: The line thickness of marks
à Range: 1mm~2mm
à Optimized Setting: 1mm

l Margin: The distance between marks and
images
à Range: 0mm~50mm
à Optimized Setting: 5mm
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Note:
1. To save your materials, in addition to amending object margins, you can also adjust the length of

the registration marks (5mm minimum) when you apply 4-Point Positioning (see table 1 for
suggestions based on different material sizes). The smaller the size is, the smaller the distance
between the object and the registration marks is (see the figures below).

Table 1
*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so please
make sure the amount you enter is reasonable.

3. If you change the paper size, you will have to reset the registration marks otherwise the previous
setting will be applied.

Page size
(unit: mm)

Suggested mark length
(unit: mm)

A6 (105 x 148) 5
A5 (148 × 210) 8
A4 (210 × 297) 11
A3 (297 × 420) 16
A2 (420 × 594) 23
A1 (594 × 841) and above 25*

Area to be cut
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Segmental Positioning
For precise cutting quality, it is suggested to select “Segmental Positioning” when you are working on
an extra long or large-sized image to increase cutting accuracy.

Segmental Positioning
l X Step: The distance of intermediate position on the X axis
l Y Step: The distance of intermediate position on the Y axis

à Range: 200mm~600mm
à Optimized Setting: Less than 500mm

The system will create the marks as shown in the picture below. Segmental Positioning



RX II Series User Manual

Illustrator Plug-In A-5

Multiple Copies
It is suggested to select “Multiple Copies” when you would like to make several copies of one image on
your material to increase cutting accuracy.

Multiple Copies
l No. of X Copies: The numbers of copies on X axis
l No. of Y Copies: The numbers of copies on Y axis

à Range: 1~50. (The more copies you make, the more
time is needed for data transmission.)
à Numbers of X Copies * Numbers of Y Copies = The
total amount of image copies

l Copies with outline：To show outlines of image
graphics

l Margin: Space between marks; must be 0 or ≧ 20,
no negative numbers allowed

The system will create the as shown in the picture below.

X axis

Y axis
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GreatCut-S
There are basic instructions of GreatCut-S below. If you need detailed instruction, please refer to
GreatCut-S Help.

A. Select the cutter you want to output and change the work area.

1. Run GreatCut-S software.

2. Select “Cutter” and select “Manage Cutters” under My Cutter to change the work area.
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3. Select company / brand as GCC and select model you want to output and then click the “<--Add
to list” button.

4. Select GCC on the left and click “Done.”

5. If you want to change the material size and orientation, you can fill a proper value in the
Document window.
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B. Insert Graphics from Library

Select graphics from library to insert a selected design.

C. Draw Text

Click on the T icon at left side to create the text and select the font you like at text window.
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D. Import Design

If you have created your design in other design software, go to “import” or “place image” under file
to import it, GreatCut-S supports svg, scut, scal, pdf, ai. wpc eps, bmp, gif, jpg and png files.

E. Convert Image to Cutting File

1. Go to Trace Image under File, or select Trace Image icon on the toolbar to open the setting
window.

Tips Thousands of SVG files available on SVGCuts!
ü http://SVGCuts.com is the top of source for designer SVG files. Thousands of high quality

elements including: shapes for card-making, scrapbooking, as well as gift bags, boxes and 3D
flowers.

http://svgcuts.com/
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2. Click on “Choose an image” to input the image, adjust Image Settings and Output Settings, and
click OK. Then the outline of the image will be outputted automatically.

Note
ü The contrast and pixels of import images will affect the trace image result. High contract

graphics are recommended.
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F. Cut the Design

1. Click on the “Cutter” button on the toolbar and Cut Settings window will pop up.

2. Click on “Settings…” to open GCC Cutter Settings window.

3. Adjust Registration Marks setting under GCC Cutter Settings window if needed.

*Registration Marks: set the distance between the edge of the material and the registration
marks in Mark Offset; set the size of marks in Mark Size; set the line thickness of marks in Mark
Thickness.

Note
ü The origin point is on the bottom right.
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4. Adjust Blade Offset, Overcut Value, Multi-Cut and Quality under Cut Settings window if needed.

*Blade Offset: set the offset value according to different blade, for a standard blade, set the
offset value at 0.25mm, 0.5mm for an optional advanced blade and 0mm for an optional
plotting pen.

*Quality: associated with the cutting result; please note the better cutting quality, the slower
cutting speed.

*Multi-Cut: to repeat the cutting job at same position which is suitable for cutting thick material.

*Overcut: allows for easier weeding and makes up for incomplete cut lines.



RX II User Manual

GreatCut-S A-6

5. Under “Cut Settings” section, there are some useful functions. After setting the parameters, click
on “Cut” to send the data to the GCC cutter and the GCC cutter will start the cutting job.

*Cut Mode: there are “WSIWYG” and “Origin Point” options, WSIWYG means what you see is
what you get, the cutter will output the graphic at same position in preview window. While
with Origin Point mode, the cutter will cut the graphic from bottom right origin point of the
material.

*Use Software Speed and Pressure: tick this section, and you can set the values of speed and
pressure manually.

*Preset: select a proper material to apply the preset speed and pressure parameter
automatically.

*Speed & Pressure: you may adjust values of speed and pressure manually to get quality results.
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G. Print and Cut Your Design

The Print and Cut function allows you to print the graphics from GreatCut-S to printer, and then put
the printed materials on the GCC cutter to cut out the contour of printed jobs from GreatCut-S.

1. Open an image file in GreatCut-S.

2. Click on the Cutter icon on the toolbar, set the parameters and click on “Print+Cut” to add the
registration marks and print out the image.
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3. Click on “Print…” to open printer setting window and click OK.

4. Print your design with registration marks out.

5. Load the printed media to the GCC cutter.

6. Press “Next” and then press “Scan+Cut”, and then the GCC cutter will detect the registration
marks and cut the contour lines automatically.
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Tips Test Connection function can save your materials.
ü Click on “Test Connection” to exam if set the connection properly.
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H. Cut by Color

The Cut by Color function allows you to choose which colors in your design you want to cut, and
designate different parameters to each color. You can cut your designs in a single job or separate
jobs for each color.

1. Select a design and specify a color for it.

Then define cut type and parameter.
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2. Click on “Cut” to open Cut Settings window.

3. Click on the Cut by Color tab and choose to either Cut all Colors in a single job or Cut each color
separately as an individual job.
When Cut each color separately is selected, GreatCut-S will prompt you between each color
before starting to cut so you can load the appropriate color or corresponding tool into your
cutting machine.

Note: If the same tool is being used for all colors in a cutting job, it is suggested to use “Cut all
colors (Single job)” .
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4. Click on the blade icon to choose the colors you want to cut. The preview will display which
colors are currently enabled for cutting.

Note: You can adjust the order of the layer arrangement by clicking and dragging the layer.

5. Click on “Cut” to start cutting.
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I. How to create Registration mark in Greatcut-S for contour cutting

Step1 Create a file

Step2 Go to Windows➜Dockers➜GteatCut-S Bridge
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Step3 Select the model with AAS function from the model menu in GreatCut-S Bridge.

Step4 Select Contour Outline, and define the offset value of contour line from the size option in
Shadow Layer menu.
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Step5 The contour line is created.

Step6 Select “Add Reg Marks” to add registration marks.
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Step7 The registration marks are added.

Step8 Select “Cut (Add to queue)” to send the file.
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Step9 Clink on “Cut” in GteatCut-S Bridge window.

Step10 Define the parameters in Cut Settings window and select “Cut”.

Step11 The process is complete.
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SignPal Instruction
The SignPal Software is Windows System compatible and all versions support the AAS II
contour cutting function.

SignPal Instruction Index:
[1] Installing the SignPal software
[2] Set up your GCC Cutter on Production Manager
[3] SignPal AAS II Quick Start
[4] How to set Die Cut
[5] How to set Creasing
[6] SignPal Features List

[1] Installing the SignPal software
To install the software, you must have Administrator privileges. To use the software, you
must have Administrator or Power User privileges. See your Windows user guide for more
information.

1. Uninstall any previous version of the software.

2. Visit GCC website (https://www.gccworld.com/download.php?act=view&id=20) to
download the WinRAR file.

https://www.gccworld.com/download.php?act=view&id=20
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3. Follow the installation and activation instruction for SignPal below.

(1) Install and activate software on an online computer

1.Launch your browser and type https://www.saicloud.com in address bar and press
enter, then input your activation code, then click Activate, activation code can be
found in the code label in software package.

2. In login section, click I am new to the SAi Cloud and input your email address,
then click Create Account, an email will be sent to your mailbox.

https://www.saicloud.com/
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3. Check your mailbox and click website link in the email then complete the
information fields.
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4. Open Autorun in the WinRAR file. Then install software step by step by following
the wizard.
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5.Paste your code into activation code field.

6.Select language you need, click OK and finish installation.
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(2) Install and activate software on an offline computer

1. Open Autorun in the WinRAR file. Then install software step by step by following
the wizard.



RX II User Manual

SignPal Instruction A-7

2. Record your computer ID in the dialog box below and look up your computer name,
You can find your computer name by right-click on My Computer and choose
Properties.

3. Launch your browser on another online computer and type
https://www.saicloud.com in the address bar and press enter, then input your
activation code and click Activate.
The Activation code can be found in the software package certificate.

https://www.saicloud.com/
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4.In login section, click I am new to the SAi Cloud and input your email address,
then click Create Account, an email will be sent to your mailbox.

5. Check your mailbox and click website link in the email then complete the
information fields.
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6.Click “License Manager” can’t connect and input your computer ID and
computer name that you recorded for the offline computer before, then click
Create license Now and Download License, save license file to local.
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7. Copy license file to offline computer via a removable disk device, then import it.

8. Select language you need, then click OK and finish installation.
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(3) Transfer license on an online computer

1.Open License Manager from Start menu.

2.Click Remove License From This computer, Now you can install the software
on another computer.
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(4)Transfer license on an offline computer
1.Open License Manager from Start menu.

2.Click Remove License From This computer, then record removal code in license
dialog box.

3.Launch your browser on another online computer, access
https://www.saicloud.com and login with your account. Click License Removed
then input removal code and click Remove. After this you can install software on
another computer.

https://www.saicloud.com/
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[2] Set up your GCC Cutter on Production Manager

1. Open Production Manager 12
2. Choose and set up your GCC cutter.

(Note that AAS II System only works on RX II, Jaguar V LX, Puma III, Expert II LX
models.)
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3. Select File > Print Setup in SignPal Software and select the printer.
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4. Select File > Document Setup in SignPal and select paper size .
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[3] SignPal AASII Quick Start

1. Use the Rectangle Tool to create a rectangle.

2. Select Effect > Contour Cut. Then click ‘Apply’ in DesignCentral window.
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3. Apply the contour cut mark of GCC AASII by selecting Effect > Contour Cut Mark.

4. Select “GCC AASII” in SignPal DesignCentral window to create the AAS II registration
marks (4-Point Positioning) and click ‘Apply’ in DesignCentral window.
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5. There are three types of GCC AASII registration marks: 4-Point Positioning, Segmental
Positioning, and Multiple Copies. To make ‘Segmental Positioning’ marks, please
select “GCC Segmentation” in DesignCentral window and then click ‘Apply’.

6. For ‘Multiple Copies’, this function is not available in SignPal. Currently the ‘Multiple
Copies’ function is only available under CorelDraw plug-in.

7. Select File > Print to print out the image.
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8. Set the Scale as 100% in Print page.

9. Load the printout vinyl on the plotter and select File > Cut Contour to send data. You
can preview the job and change cutter’s parameter settings in ‘Properties’ tab of Cut
Contour window. The Production Manager will be automatic activated to complete the
job.
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[4] How to set Die Cut
1. Open SignPal Expert

2. Use the “Text” tool or other drawing tools to create an image.
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3. Select “Contour Cut” tool to create contours of the image.

4. Select Fill/Stroke Editor and select Edit from dropdown menu.

5. Set Die Cut parameter in Customize Line Styles

Note：Dash: define the length of cutting line; Gap: define the interval between the dash lines
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6. Select Cut/plot icon to open the setting window

7. Select the model you are using from the dropdown menu, and click Edit… to open the Driver

options setting window.
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8. Set parameter in Before Job tab.

Note: Set Tool = 0 to perform cutting.

9. Enter a value in Passes column to define the repeat times.

10. The setting is complete.
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[5] SignPal Features List

Expert Apprentice
Text
Text Tool ● ●

Arc Text ●

Path Text ●

Vertical Text ● ●

Vertical Path Text ●

Kerning ●

Break Apart/ Join ● ●

Drawing
Bezier ● ●

Freehand Drawing ● ●

Shapes
Rectangle ● ●

Oval ● ●

Registration Mark Tool ● ●

Measure Tool ● ●

Path Editing
Select Point Tool ● ●

Remove Point ●

Add Point ●

Straighten Path ●

Round Corner ●

Sharpen Corner ●

Optimize by Curve ●

Optimize by Smooth
Arc ●

Optimize by 3point Arc ●

Make Arc ●

Reduce Points ●

Close Path ●

Change Start Point ●

Cleaver ●
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Scissors ●

Make Right Angle ●

Break Path ●

Join Paths ●

Align Horizontal ●

Align Vertical ●

Align Points ●

Apply Length and
Angle ●

Remove Tiny Objects ●

Vector Eraser ●

Cleaver by Path ●

Working with Files
Job Info ●

Scanning ●

Achieve to Cloud ● ●

Workspaces ● ●

View
DesignCentral ● ●

Color Mixer ● ●

Snap ● ●

Arrange
Group ● ●

Compound ● ●

Mask ● ●

Guides ● ●

Contour Cut ● ●

Convert to Outlines ● ●

Convert Stroke to
Outlines ● ●

Convert Linked to
Native ● ●

Path Direction ● ●

Order ● ●

Cut Order ● ●
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Align ● ●

Spacing ● ●

Rotate ● ●

Resize ● ●

Deskew ● ●

Mirror ● ●

Step and Repeat ●

Effects
Combine ●

Outline ●

Contour Cut ● ●

Contour Cut Mark ● ●

Shadow ●

Bitmap
Autotrace ●

Color Mode ●

Production
Cut/Plot ● ●

Manual Split Lines ● ●

Tile All Copies ● ●

Panel to Border ● ●

Auto-weld ● ●

Auto-trap ● ●

Overcut ● ●

Optimize Cutting Order ● ●
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Sure Cuts A Lot

There are basic instructions of Sure Cut A Lot below. If you need detailed instruction, please
refer to Sure Cut A Lot Help.

1. Select the cutter you want to output and change the work area.

Step 1 Run Sure Cuts A Lot software.

Step 2 Select “Cutter” and select “Manage Cutters” under My Cutter to change the work
area.
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Step 3 Select company / brand as GCC and select model you want to output and then click
the “<--Add to list” button.

Step 4 Select GCC on the left and click “Done.”

Step 5 If you want to change the material size and orientation, you can fill a proper value in
the Document window.
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2. Insert Graphics from Library

Step 1 Select graphics from library to insert a selected design.

3. Draw Text

Click on the T icon at left side to create the text and select the font you like at text window.
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4. Import Design

If you have created your design in other design software, go to “import” or “place image”
under file to import it, SCA supports svg, scut, scal, pdf, ai. wpc eps, bmp, gif, jpg and png
files.

Tips Thousands of SVG files designed specifically for Sure Cuts A Lot!
ü http://SVGCuts.com is the top of source for designer SVG files for Sure

Cuts A Lot. Thousands of high quality elements including: shapes for
card-making, scrapbooking, as well as gift bags, boxes and 3D flowers.

http://svgcuts.com/
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5. Convert Image to Cutting File

Step 1 Go to Trace Image under File, or select Trace Image button on the toolbar to open
the setting window.

Step 2 Click on “Choose an image” to input the image, adjust Image Settings and Output
Settings, and click OK. Then the outline of the image will be outputted automatically.

Note
ü The contrast and pixels of import images will affect the trace

image result. High contract graphics are recommended.
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6. Cut the Design

Step 1 Click on the “Cutter” button on the toolbar and Cut Settings window will appear.

Step 2 Click on “Settings…” to open GCC Cutter Settings window.

Step 3 Adjust Registration Marks setting under GCC Cutter Settings window if needed.

*Registration Marks: set the distance between the edge of the material
and the registration marks in Mark Offset; set the size of marks in Mark
Size; set the line thickness of marks in Mark Thickness.

Note
ü The origin point is on the bottom right.
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Step 4 Adjust Blade Offset, Overcut Value, Multi-Cut and Quality under Cut Settings window
if needed.

*Blade Offset: set the offset value according to different blade, for a
standard blade, set the offset value at 0.25mm, 0.5mm for an optional
advanced blade and 0mm for an optional plotting pen.

*Quality: associated with the cutting result; please note the better
cutting quality, the slower cutting speed.

*Multi-Cut: to repeat the cutting job at same position which is suitable
for cutting thick material.

*Overcut: allows for easier weeding and makes up for incomplete cut
lines.
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Step 5 Under “Cut Settings” section, there are some useful functions. After setting the
parameters, click on “Cut” to send the data to the GCC cutter and the GCC cutter will
start the cutting job.

*Cut Mode: there are “WSIWYG” and “Origin Point” options, WSIWYG
means what you see is what you get, the cutter will output the graphic
at same position in preview window. While with Origin Point mode, the
cutter will cut the graphic from bottom right origin point of the material.

*Use Software Speed and Pressure: tick this section, and you can set
the values of speed and pressure manually.

*Preset: select a proper material to apply the preset speed and
pressure parameter automatically.

*Speed & Pressure: you may adjust values of speed and pressure
manually to get quality results.
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7. Print and Cut Your Design

The Print and Cut function allows you to print the graphics from Sure Cuts A Lot to printer,
and then put the printed materials on the GCC cutter to cut out the contour of printed jobs
from Sure Cuts A Lot.

Step 1 Open an image file in Sure Cuts A Lot.

Step 2 Click on the Cutter icon on the toolbar, set the parameters and click on “Print+Cut” to
add the registration marks and print out the image.
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Step 3 Click on “Print…” to open printer setting window and click OK.

Step 4 Print your design with registration marks out.

Step 5 Load the printed media to the GCC cutter.

Step 6 Press “Next” and then press “Scan+Cut”, and then the GCC cutter will detect the
registration marks and cut the contour lines automatically.
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Tips Test Connection function can save your materials.
ü Click on “Test Connection” to exam if set the connection properly.
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8. Cut by color (*only available in RXII and RXII(Creasing) model)

Cut by color is a function to set multiple parameters with 16 different colors in stroke of
graphic that can help easily to identify different job.

Step 1 Select “Cutter” and select “GCC RXII” under My Cutter to change the work area.

Step 2 Select graphics from library to insert the selected design.
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Step3 Click the area you want to design and select pen color to designate stroke color for
setting parameter in the next step then clicks “OK”.

Step4 Click the button to open the Edit Presents window which shows the default
values by different materials. You can adjust the parameter and click “OK” to save the
changes.
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Step5 Click on the “Cutter” button on the toolbar to open Cut Settings window.

Step6 Click on the “Cut By Color” then click” Cut “button and cutter will to work.
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9. Creasing (*only available in RXII (Creasing) model)

Equipped with the dual tool holders with creasing tool and blade, RX II-61 (Creasing) model
offers perfect creasing line and cutting result at one time for short run production in package
or custom products.
(PS. It’s suggested to use the cardstock weight range from 200 to 350 gsm. The paper
weight may vary according to the type and thickness of paper being used.)

Step 1 Go to “Cutter” and select “GCC RXII-CR” under My Cutter to change the work area.

Step 2 Import your design or insert a graphic from library.
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Step 3 Select the outline you want to crease and set the cut line type as “Draw(Pen)”and tool
as “2(left-Creasing)” for creasing. Then click the button to open the “Edit Presents”
window which shows the default values for creasing. You can adjust the parameter and click
“OK” to save the changes.

Step 4 Select the outline you want to cut and set the cut line type as “Cut” and tool as
“1(right)” for cutting. Then click the button to open the “Edit Presents” window which
shows the default values by different materials. You can adjust the parameter and click “OK”
to save the changes.
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Step5 Click on the “Cutter” button on the toolbar to open Cut Settings window.

Step6 Click on the “Layers” then click “Cut” button and cutter will start to work.


